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A. MỤC ĐÍCH, YÊU CẦU:


- HS nắm được cơ bản thế nào là bảng tính, công dụng của bảng tính.

- Biết được nhu cầu sử dụng bảng tính trong đời sống và trong học tập.


- Biết được các chức năng của chương trình bảng tính.

B. PHƯƠNG PHÁP: 
 
- Hỏi – đáp, thuyết trình, quan sát trực quan, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI MỚI:


* HOẠT ĐỘNG 1: Giới thiệu

   Hằng ngày con người ta cần phải giải quyết rất nhiều công việc như: soạn thảo văn bản, thiết kế, tính toán, làm việc nhà,… Để tiện cho việc theo dõi, tính toán, so sánh, sắp xếp,… dữ liệu một cách chính xác, khoa học, nhanh chóng,… ta cần phải có phương tiện để giúp con người trong lĩnh vực này đó là?


* HS: Máy tính và phần mềm máy tính.

?Vậy phần mềm hỗ trợ cho công việc này gọi là phần mềm gì?


* HS: Phần mềm ứng dụng.


* GV: Để hiểu rõ là phần mềm ứng dụng nào ta tìm hiểu bài mới.


* HOẠT ĐỘNG 2: Tìm hiểu bảng tính và nhu cầu xử lí thông tin dạng bảng.

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Để tiện theo dõi điểm học môn tin của các em ta cần làm gì để tiện theo dõi?

* HS: Tạo bảng

?Các em đã học ở lớp 6 về tạo bảng hãy cho biết khi nào thì cần tạo bảng?

* HS: Khi cần theo dõi, so sánh, tính toán sáp xếp,…
?Tạo bảng có những ưu điểm gì? – HS trả lời

?Hãy cho biết cách tạo bảng ở Word – HS trả lời

*GV: Để tiện cho việc theo dõi, so sánh, tính toán, sắp xếp, lọc dữ liệu,… ta cấn phải sử dụng bảng để lưu  trữ dữ liệu

*GV: Chiếu ví dụ “Bảng điểm lớp 7A, SGK trang 3

*HS: Quan sát
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?Nhìn vào bảng điểm em dễ dàng nhận ra điều gì?

* HS: Kết quả học tập của từng học sinh

* Ví dụ 2: Dựa vào cách lập bảng em có thể tự lập bảng theo dõi kết quả học tập của em không?

* HS: Trả lời

* GV: chiếu ví dụ 2 SGK trang 4 – HS quan sát
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* GV: Trong thực tế nhu cầu của con người rất lớn cần trình bày dữ liệu ở những dạng khác nhau.
?Hãy kể ra một số dạng trình bày mà em hay sử dụng?

* HS: Thời khoá biểu, đo lượng mưa, bảng lương, theo dõi kết quả học tập của em, sổ điểm vắng,…

* GV: - Chiếu ví dụ 3: SGK trang 4 – HS quan sát

           - Trong thực tế ta không chỉ có đơn thuần sử dụng bảng mà còn cần biểu đồ để so sánh, lọc ra những chỉ tiêu mình cần. Như vậy cần phải có phàn mềm ứng dụng hỗ trợ cho công việc này là rất cần thiết đó là chương trình bảng tính điện tử (Excel). Nhờ vào chương trình này ta có thể dễ dàng thực hiện được các công việc trên dựa vào máy tính điện tử.
* HS: Ghi bài

?Vậy chương trình bảng tính điện tử là gì?
* HS: Là một phần mềm ứng dụng
	1. BẢNG TÍNH VÀ NHU CẦU XỬ LÍ THÔNG TIN DẠNG BẢNG: 

 Chương trình bảng tính là pjhần mềm được thiết lập để ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các tính toán cũng như xây dựng các biểu đồ biểu diễn một cách trực quan các oó liệu có trong bảng.

	HOẠT ĐỘNG 3: Tìm hiểu chương trình bảng tính

	* GV: Hiện nay có rất nhiều chương trình bảng tính khác nhau như: Quattropro Microsoft Office Excel, Assco,… tuy nhiên chúng đều có một số đặc điểm chung.

* GV: Chiếu cửa sổ làm việc của chương trình bảng tính Excel – HS quan sát

* GV: Thực hiện một số thao tác như: nhập vào kí tự, số, hình ảnh – HS  quan sát. Từ bảng điểm ta có thể ta có thể lấy ra được điểm trung bình.

?Hãy rút ra đặc trưng chung của bảng tính  - HS trả lời

* GV: Để làm việc thuận tiện với bảng tính ta phải  hiểu màn hình làm việc của bảng tính.

?Hãy nhớ lại và cho biết màn hình làm việc của cửa sổ Word? – HS trả lời

* GV: Cho HS quan sát màn hình của Excel – HS quan sát.

( HS so sánh với màn hình làm việc của cửa sổ Word.

?Hãy cho biết màn hình làm việc của bảng tínhcó những đặc trưng gì?

* HS:  - Có thanh bảng chọn, thanh công cụ, cửa sổ làm việc chính

?Hãy cho biết có những dạng dữ liệu nào?

* HS: Dạng số, hình ảnh, âm thanh.

* GV: Chiếu một số dạng dữ liệu – HS quan sát

* GV: Chốt lại dạng số, phi số, tin tức, sự kiện

?Hãy cho ví dụ về dạng số?

* HS: Điểm kiểm tra, số liệu, số điện thoại…
?Hãy cho ví dụ về dạng văn bản?

* HS: Họ tên, bài thơ, bài hát, bài văn, thứ ngày,…

* GV: Thực hiện một số thao tác  ví dụ: Tính điểm trung bình, thực hiện tính toán với số liệu lớn,…

* HS: Quan sát

?Qua tìm hiểu về bảng tính em nào cho biết chương trình bảng tính có những khả năng nào?

* HS: Trả lời

* GV: Chương trình bảng tính có khả năng tính toán tự động, tìm kiếm, sắp xếp, cập nhật tự động.

* GV: Thực hiện một số thao tác lọc ra số học sinh giỏi có trong danh sách, sáp xếp danh sách theo điểm môn toán  giảm dần,…
* HS: Quan sát

?Hãy cho biết chương trình bảng tính còn có những khả năng nào? – HS trả lời

?Qua quan sát các thao tác cô vừa thực hiện em thấy thực hiện các công việc trong bảng tính như thế nào?

* HS: Nhanh chóng, thuận tiện, dễ dàng

* GV: Chiếu lại bảng thống kê ở ví dụ 3 SGK trang 4

* HS: Quan sát

?Hãy cho biết làm thế nào để so sánh được tỉ lệ loại đất?

* HS: Ta có thể sử dụng biểu đồ để so sánh.

? Tìm hiểu thực tế hãy cho biết biểu đồ có những dạng nào?

* HS: Dạng cột, dạng vành khuyên,…
	 2. CHƯƠNG TRÌNH BẢNG TÍNH:

  * Công cụ đặc trưng của bảng tính:     Có thanh công thức và bảng chọn DATA

 a. Màn hình làm việc:

  - Các bảng chọn

  - Các nút lệnh thường dùng

  - Cửa sổ làm việc chính

  b. Dữ liệu:

  Dạng số, văn bản và kết quả tính toán luôn được trình bày dưới dạng bảng trong cửa sổ làm việc.

 c. Khả năng tính toán và sử dụng hàm có sẵn:

 - Thực hiện cập nhật tự động công việc tính toán.

 - Sử dụng hàm để tính toán rất thuận tiện.

 d. Sắp xếp và lọc dữ liệu:

- Dễ dàng, nhanh chóng lại thuận tiện.

e. Tạo biểu đồ:

 Là một trong những dạng trình bày dữ liệu cô đọng, trực quan.


E. CỦNG CỐ: - Cần nắm được thế nào là bảng tính, nhu cầu xử dụng thông tin dưới dạng bảng.


-  Các chức năng chung của chương trình bảng tính là: Màn hình làm việc, dữ liệu, khả năng tính toán, sắp xếp và lọc dữ liệu, tạo biểu đồ.
F. DẶN DÒ: - Về làm bài tập 1, 2  SGK trang 9

   - Xem tiếp bài 1 phần 3 và 4 SGK trang 7, 8 để tiết sau học tiếp


A. MỤC ĐÍCH, YÊU CẦU:


- Nhận biết được các thành phần cơ bản của màn hình trang tính (bảng tính).

- Hiểu rõ khái niệm hàng, cột, địa chỉ ô tính.


- Biết nhập, sửa, xoá dữ liệu trên ô tính.


- Biết cách di chuyển ô tính trên trang tính.


- Biết cách di chuyển đến từng trang tính

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, trao đổi theo cặp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Chương trình bảng tính là gì?


2) Hãy cho biết những công cụ đặc trưng của bảng tính điện tử


* BÀI MỚI:


* HOẠT ĐỘNG 1: Tìm hiểu màn hình làm việc của chương trình bảng tính.

	Hoạt động giáo viên và học sinh
	Nội dung

	* Để thực hiện công việc được trong bảng tính thì ta phải biết và hiểu rõ màn hình làm việc của chương trình bảng tính.

?Hãy cho biết các tính chất chung của màn hình làm việc Word? – HS trả lời
*GV: Khởi động phần mềm bảng tính Excel
* HS: Quan sát

?Hãy mô tả màn hình làm việc của bảng tính?

* HS: Trả lời

 * GV: Chốt lại và hướng dẫn chi tiết, cụ thể từng tính chất của cửa sổ bảng tính – HS quan sát
 * GV: Giới thiệu để học sinh rõ vùng soạn thảo của chương trình được gọi là “trang tính” gồm có cột. hanhg, ô dùng cho công việc nhập dữ liệu, chỉnh sửa, tính toán dữ liệu.

* HS: Trao đổi theo cặp tìm hiểu thế nào là trang tính?

* HS: Trả lời

* GV: Chốt lại

* GV: Hướng dẫn để HS phân biệt được cột có tiêu đề cột dòng có tiêu đề dòng  - HS: Quan sát

?Cho biết cột được đánh số tự như thế nào?

* HS: Cột được đánh số thứ tự theo các chữ cái A, B, C, D,…, 

?Hàng được đánh số thứ tự như thế nào?

* HS: Hàng được đánh số thứ tự là các chữ số 1, 2, 3, 4

* GV: Hướng dẫn rõ đâu là ô tính (là vùng giao nhau giữa cột và hàng)
Ví dụ: ô A2 có nghĩa là ô nằm ở cột A hàng 2

* HS: Quan sát.

?Nêu cách chọn khối ô ở Word? – HS: Trả lời

* GV: Ở trang tính cách chọn khối ô cũng tương tự như vậy.

?Gọi hai em lên chọn khối ô – HS thao tác

* GV: Các em đã được làm quen với màn hình làm việc của trang tính. Vậy cách nhập dữ liệu và sửa dữ liệu như thế nào? – HS trả lời
	3. Màn hình làm việc của chương trình bảng tính:

- Thanh tiêu đề

- Thanh bảng chọn: chứa các bảng chọn File, Edit, Insert, Format, Data,…
- Thanh công cụ chứa các nút lệnh thường dùng.

- Thanh công thức, hộp tên có chứa “Fx” dùng để nhập, hiển thị dữ liệu hoặc công thức trong ô tính.

- Bảng chọn Data gồm các lệnh để xử lí dữ liệu.

* Trang tính là miền làm việc chính của bảng tính gồm có các cột, các hàng và các ô tính.

  + Vùng giao nhau giữa cột và hàng gọi là ô tính dùng để chứa dữ liệu.

 + Tên cột được đánh số thứ tự A, B, C,…

  + Tên hàng được đánh số thứ tự là các chữ số 1, 2, 3, 4, …

  + Ô được đánh số tên cột trước hàng sau.

  Ví dụ: A5, B2, C9

  + Khối ô là tập hợp các ô tính liện kề nhau.

	HOẠT ĐỘNG 2: Tìm hiểu cách nhập dữ liệu vào trang tính

	* Nhập dữ liệu ở trang tính khác với nhập dữ liệu ở Word vì muốn nhập dữ liệu vào ô nào ta phải chọn ô đó (kích hoạt ô đó) và dữ liệu sẽ được lưu ở ô tính đó còn các ô khác không nhập dữ liệu thì sẽ không có dữ liệu .
+ GV: Thao tác mẫu – HS quan sát

*  Gọi hai HS thao tác – HS thao tác.

* GV: Thao tác mẫu – HS quan sát

*  Gọi hai HS thao tác – HS thao tác.

?Cho biết các cách di chuyển con trỏ đến các ô trong bảng ở Word? – HS trả lời

* GV: Đẻ di chuyển con trỏ đến các ô tính cũng tương tự như di chuyển con trỏ trong bảng ở Word.

* GV: Thao tác mẫu – HS quan sát

* Gọi hai em thao tác – HS thao tác

?Hãy cho biết cách chọn để gõ tiếng Việt mà em biết?

* HS: Trả lời

* GV: Để gõ được chữ việt trên trang tính cách làm tương tự như ở Word

?Gọi 1 HS khởi động phần mềm Vietkey – HS thao tác
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* GV: Thao tác mẫu – HS quan sát

* Gọi hai em thao tác lại
	a. Nhập và sửa dữ liệu:

 * Nhập dữ liệu:

 B1) Nháy chuột chọn ô cần nhập dữ liệu

B2) Gõ dữ liệu từ bàn phím.

B3) Gõ phím Enter để kết thúc nhập dữ liệu. 

* Sửa dữ liệu:

- C1. Nháy đúp chuột vào ô cần sửa → sửa → gõ phím Enter để kết thúc

- C2. Nháy chọn ô cần sửa → gõ F5 →  Sửa →  gõ phím Enter để kết thức

- C3. Nháy chọn ô cần sửa →  nháy chuột vào thanh công thức →  sửa →  gõ phím Enter để kết thúc.

 B. Di chuyển trên trang tính:
Phím

Chức năng

- Con chuột

- Nháy chuột vào ô cần đến.
- →, (, (, (
- Sang phải 1 ô, sang trái 1 ô, lên 1 ô, xuống 1 ô
- Home

- Về ô đầu tiên của hàng

- End + (
- Về hàng 1 của trang tính

- End + (
- Về hàng cuối của trang tính

Gõ địa chỉ ô vào hộp tên

- Đến ô bất kì

C. Gõ chữ việt trên trang tính:
 - Sử dụng phần mềm Vietkey hoặc Unikey

* Chú ý:  Trước khi chọn phông tiếng việt cần chọn cả trang tính bằng cách nháy chuột vào ô giao nhau giữa tên cột và tên hàng ở góc trên bên trái


* HOẠT ĐỘNG 3:    Bài tập
Câu 1:  Phân biệt bảng tính, trang tính, trang màn hình?


* Bảng tính:  Là phần mềm dùng để tính toán, là tệp tin (File)


* Trang tính:  
-  Là vùng soạn thảo chính gọi là Sheet gồm có cột, hàng, ô.





- Một bảng tính gồm có nhiều trang tính


* Trang màn hình:  Là vùng soạn thảo mà ta nhìn thấy ở màn hình làm việc.

Bài 5 SGK trang 9: Ô tính đang được kích hoạt có đường viền đen bao quanh, các nút tiêu đề cột, hàng hiển thị màu vàng, địa chỉ ô tính được hiển thị ở hộp tên.
E. CỦNG CỐ: - Cần nắm vững màn hình làm việc của Excel có công cụ đặc trưng gì?


- Nhập và sửa dữ liệu



- Di chuyển đến các ô tính


- Phân biệt được đâu là bảng tính, trang tính, trang màn hình

F. DẶN DÒ: - Xem lại toàn bộ nội dung bài một


- Tập thực hành bài thực hành 1 để tiết sau thực hành.


- Làm các bài tập còn lại ở SGK trang 9.

A. MỤC ĐÍCH, YÊU CẦU:


- Khởi động và kết thúc Excel

- Nhận biết các ô, hàng, cột, hộp tên, thanh công thức trên trang tính.


- Biết cách di chuyển con trỏ chuột trên trang tính.


- Biết chọn khối ô.


- Biết cách di chuyển đến từng trang tính

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính
C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Hãy cho biết các cách di chuyển con trỏ soạn thảo trên trang tính?


2) Nêu cách nhập và chỉnh sửa dữ liệu trên ô tính?


* BÀI MỚI:

	Hoạt động giáo viên 
	Hoạt động học sinh

	Câu 1: Khởi động Excel
	Câu 1:  Nháy đúp chuột vào biểu tượng Excel

	Câu 2: 
Lưu tên bảng tính
	Câu 2: B1) File → Save

B2) Chọn đường dẫn để lưu tên tệp

B3) Gõ tên tệp vào khung File Name                             chọn Save

	Câu 3: Lưu kết quả vào trang tính
	Câu 3: C1) File → Save

 C2)Nháy chọn nút lệnh  [image: image4.bmp] trên thanh công cụ

	Câu 4: Nhận biết tên cột, tên hàng, ô tính, thanh công thức và bảng Data
	Câu 4: HS nhận biết tên cột, tên hàng, ô tính, thanh công thức và bảng Data bằng cách quan sát trực quan trên phần mềm

	Câu 5: -Di chuyển con trỏ soạn thảo trên trang tính

- Chọn khối ô
	Câu 5: - HS thao tác sử dụng các phím để di chuyển hoặc nháy chuột để chọn

- Chọn khối ô: + Di chuyển chuột để chọn một vùng
  + Chọn 1 ô: Nháy chuột vào ô cần chọn.

  + Chọn một hàng:  Nháy chuột vào tên hàng
  + Chọn  1 cột: Nháy chuột vào tên cột

	Câu 6: Nhận biết trang tính, trang màn hình, bảng tính
	Câu 6:  Học sinh quan sát trực quan trên máy tính để phân biệt đâu là bảng tính, trang tính, trang màn hình

	Câu 7:  Chọn bảng mã, phông chữ tiếng việt
	Câu 7: Học sinh thao tác trực tiếp trên máy tính

	Câu 8:  Thoát khỏi cửa sổ bảng tính điện tử
	Câu 8:  C1) Nháy chọn nút Close trên thanh tiêu đề

C2) Gõ tổ hợp phím Alt + F4


* GV: - Hướng dẫn học sinh thực hành đúng, sửa sai (nếu có)


- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ:  - Về làm bài tập 2, 3 SGK trang 11 

- Tập thao tác trên máy tính với phần mềm Excel để tiết sau thực hành tiếp.

A. MỤC ĐÍCH, YÊU CẦU:


- HS biết vận dụng lí thuyết đã học ở bài một để thực hành trên máy nhập và chỉnh sửa dữ liệu trên ô tính của trang tính.

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Lên máy thao tác chọn phông chữ, bảng mã tiếng việt?


2) Thao tác nhập vào máy bảng điểm của em?


* BÀI MỚI:

	Hoạt động giáo viên 
	Hoạt động học sinh

	Câu 1:  Khỏi động bảng tính điện tử
	- Học sinh thao tác

	Câu 2: Làm bài tập 2 SGK trang 11
	B1) Chọn phông tiếng việt

B2) Nháy chuột vào ô giao nhau giữa tên cột và tên hàng để chọn cả trang tính.

B3) Chọn phông tiếng việt: Nháy chọn nút lệnh Font → chọn phông tương ứng với bảng mã.
B4) Nhập dữ liệu cho ô tính

* Thực hiện các thao tác kết hợp với quan sát để đưa ra nhận xét kết quả sau khi thao tác.

   + Chọn 1 ô có dữ liệu và gõ phím Delete (VD: ô A3)

   + Chọn 1 ô khác có dữ liệu và gõ nội dung mới. (VD: ô B5)

 - Nhận xét:  + ô A3 dữ liệu được xóa  sạch

                     + ô B5: dữ liệu cũ cũng bị xóa sạch và được thay thế bằng dữ liệu mới vừa nhập vào.

	Câu 3:  Làm bài tập 3 SGK trang 11
	* Yêu cầu: - Nhập dữ liệu cho 15 hàng với họ tên, điểm các môn

  - Tập di chuyển con trỏ chuột  trên trang tính.
  - Lưu tên tệp với tên “BAI_TH1” vào ổ đĩa D

  - Tập chỉnh sửa tên, điểm.

  - Lưu dữ liệu vừa chỉnh sửa vào máy (nháy chọn nút lệnh Save trên thanh công cụ)

  - Thoát khỏi cửa sổ Excel (File → Exit)

  - Thoát khỏi CPU (Start → Turn off computer → Turn off


* GV:  - Hướng dẫn học sinh thực hành đúng, sửa sai (nếu có)


- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ:  - Về nhà đọc bài đọc thêm “Chuyện cổ tích về Visicalc”.


- Chuẩn bị bài mới bài 2: “Các thành phần chính và dữ liệu trên trang tính” phần 1 và 2 để tiết sau học.


- Tập thao tác trên máy tínạonhapj và chỉnh sửa dữ liệu với phần mềm Excel để rèn luyện kĩ năng thao tác trên máy tính được thành thạo.

A. MỤC ĐÍCH, YÊU CẦU: HS cần:

- Hiểu và biết một bảng tính gồm nhiều trang tính và cách kích hoạt trang tính trên bảng tính.

- Biết các thành phàn chính trên trang tính gồm: Hộp tên, khối, hàng, cột, ô, thanh công thức, địa chỉ ô.


- Hiểu vai trò của thanh công thức.

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, trao đổi theo cặp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động Excel và gõ dữ liệu sau vào ô tính A2 “Hôm nay lớp 7 đi học môn tin” sau đó sửa lại nội dung “Ngày mai lớp 7 konng đi học môn tin”.

2) Lưu tệp tin vừa tạo theo đường dẫn “D:\LOP7\BAI2”.


* BÀI MỚI:


* HOẠT ĐÔNG 1: Giới thiệu


Để làm việc thuận tiện với Excel ta cần phải hiểu rõ và nắm vững bảng tính, đó là hiểu các thành phần chính trên trang tính. Vậy các thành phần chính là gì? Để hiểu rõ vấn đề này ta tìm hiêu bài mới.

* HOẠT ĐỘNG 2: Tìm hiểu  bảng tính điện tử.

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Bảng tính điện tử lâu nay ta vẫn gọi là phần mềm Excel gồm ba trang tính ngầm định (Sheets1, Sheets2, Sheets3)
?Nhìn ở đâu ta thấy được Sheets1, ..?

* HS: Nhìn ở cuối màn hình

* GV: Mở cửa sổ Excel giới thiệu cho HS rõ bảng tính chính là một cửa sổ để ta làm việc nó gồm nhiều cột, hàng, ô.

?Hãy cho biết bảng tính có những đặc trưng nào?

* HS: Có thanh công thức và bảng chọn Data

?Thế nào là bảng tính? – HS trả lời

* GV: Thao tác chuyển đổi giữa trang tính này với trang tính khác – HS quan sát.

?Nhìn vào màn hình hãy cho biết hiện tại trang tính nào đang được kích hoạt? Vì sao em biết?

* HS: Nhìn vào tên nhãn có màu trắng và chữ đậm

?Ta có thể đổi tên nhãn được không?

* HS: Ta có thể đổi tên nhãn như đổi tên tệp.

* GV: Di chuyển thanh cuộn cho học sinh quan sát trang tính để thấy rõ một trang tính có thể có nhiều trang màn hình – HS quan sát.

* Gọi hai em lên thao tác kích hoạt trang tính – HS thao tác.

* GV: Mở thêm khoảng 5 trang tính – HS quan sát

?Hiện tại bảng tính có mấy trang tính?

* HS: Hiện tại bảng tính có 5 trang tính
	1. Bảng tính: 

  - Bảng tính là một tệp tin gồm có nhiều trang tính, mỗi trang được phân biệt bởi tên nhãn.

* Đổi tên nhãn: Nháy phải chuột tại tên nhãn cần đổi → chọn Rename → gõ tên mới → Gõ phím Enter.

  + Mỗi trang tính có thể có nhiều trang màn hình.

	HOẠT ĐỘNG 3: Tìm hiểu các thành phần chính trên trang tính

	* HS: Trao đổi theo cặp bằng cách quan sát hình ảnh ở SGK kết hợp với bài mẫu trên máy tính.

?Hãy cho biết trang tính có những thành phần nào giống cửa sổ Word. – HS trả lời

?Hãy cho biết em nhìn thấy những gì trên trang tính?

* HS: Trả lời

* GV: Ở bài trước các em đã nắm được trang tính có ô, cột, hàng bây gời các em sẽ được tìm hiểu thêm một số thành phần cơ bản khác như hộp tên, khối, thanh công thức, tên cột, tên hàng – HS quan sát.
* GV: Thao tác nháy chọn một ô tính – HS quan sát

?Hãy cho biết ô đang được kích hoạt nằm ở vị trí nào? Nhìn vào đâu để biết được? 

* HS:  Trả lời nhìn vào hộp tên để biết địa chỉ ô đang được kích hoạt.

?Hãy chỉ ra đâu là hộp tên – HS lên máy chỉ ra

* GV: Chỉ lại đâu là hộp tên để cả lớp quan sát lại – HS quan sát.
* Gọi hai em lênh (tùy ý nháy chọn ô) cho biết ô tính nào đang được kích hoạt?
* HS: Thao tác và trả lời

?Các em đã học ở Word về khối ô hãy cho biết thế nào là khối ô? – HS trả lời

* GV: Ở trang tínhkhối cũng là một hình chữ nhật được chọn có màu đen

?Hãy cho biết các cách chọn khối? – HS trả lời

* GV: Nháy chọn một ô, một hàng, một cột, một khối ô,…

?Đó có phải là các khối không?

* HS: Đó chính là các khối vừa được chọn

?Vậy khối có thể là? – HS trả lời

* Gọi ba em lên thao tác chọn khối – HS thao tác.
?Hãy cho biết cách chọn khối? – HS trả lời
* Gọi hai em lên thao tác – HS thao tác

?Ngoài các đặc trưng trên trang tính còn có đặc trưng gì? – HS: Thanh công thức

* GV: Gõ dữ liệu để học sinh quan sát trên thanh công thức.

?Thanh công thức có vai trò đặc biệt gì? – HS trả lời
	2. Các thành phần chính trên trang tính:

* Hộp tên:  Là ô nằm ở góc trái thanh công thức. Hiển thị địa chỉ ô đang được kích hoạt.

 * Khối: - Là một nhóm các ô được chọn liền kề tạo thành hình chữ nhật, có màu đen.

 - Khối có thể là: + 1 ô

      + 1 hàng, 1 cột

      + 1 phần hàng, cột (nhiều ô liền kề)

 * Cách chọn khối:

C1) Di chuyển chuột để chọn.

C2) Nháy chọn ô đầu + giữ phím Shift + nháy chọn ô cuối cần chọn

C3) Nháy vào tên cột, tên hàng cần chọn

 * Thanh công thức:

 - Vai trò đặc bịêt của thanh công thức dùng để nhập, hiển thị dữ liệu và công thức, sửa nội dung trong ô tính


E. CỦNG CỐ:

- Cần phân biệt rõ bảng tính, trang tính, trang màn hình, ô tính, cột, hàng, khối.

- Nắm vững chức năng của hộp tên và thanh công thức.

F. DẶN DÒ:


- Về làm bài tập 1, 2 SGK trang 18.


- Học thuộc lí thuyết vừa học.


- Xem tiếp bài 2 phần 3 và 4 để tiết sau học.

A. MỤC ĐÍCH, YÊU CẦU: 

- Phân biệt được kiểu dữ liệu số, kiểu dữ liệu kí tự.

- Biết cách chọn ô, hàng, cột và khối ô

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Hãy lên chỉ rõ đâu là bảng tính, trang tính, trang màn hình.


2) Hãy cho biết chức năng của hộp tên và vai trò thanh công thức.


3) Hãy chỉ tên nhãn trang tính và đổi tên nhãn Sheets1 thành “BAI1”

* BÀI MỚI:



* HOẠT ĐỘNG 1: Tìm hiểu  cách chọn các đối tượng trên trang tính.

	Hoạt động giáo viên và học sinh
	Nội dung

	* Để thao tác được trên trang tính ta phải kích hoạt đối tượng (thao tác chọn).

?Hãy nêu cách chọn khối ở Word? – HS trả lời.

* GV: Thao tác chọn ở trang tính cũng như thế. 

?Gọi hai em lên thao tác – HS thao tác.

?Hãy cho biết các đối tượng trên trang tính?

* HS: Các đối tượng gồm: ô, hàng, cột.
* Gọi ba em thao tác – HS thao tác

* GV: Chiếu một bảng dữ liệu  bao gồm có chữ cái, chữ số, kiểu ngày.

* HS quan sát
	 3.  Chọn  các đối tượng trên trang tính:

- Chọn 1 ô: Nháy chuột vào ô cần chọn.

- Chọn 1 hàng: Nháy chuột vào nút tên hàng.

- Chọn 1 cột: Nháy chuột vào nút tên cột.

- Chọn 1 trang tính: Nháy chuột vào nút tên nhãn 

- Chọn 1 khối:  di chuyển chuột để chọn. 

	HẠOT ĐỘNG2: Tìm hiểu dữ liệu trên trang tính

	?Hãy cho biết có những kiểu dữ liệu nào?

* HS: dữ liệu gồm có kiểu: số, kí tự

* GV: Các em đã học ở Word có các loại dữ liệu chữ cái, chữ số, các kí hiệu đặc biệt, âm thanh, hình ảnh. Thì ở bảng tính cũng vậy.

Ví dụ: 157, -35, +10, 45%, 12,5

* Gọi 1 HS lên nhập dữ liệu vào ô tính – HS nhập dữ liệu

A

B

C

1

157

-85

+10

2

35%

15.8

Đi

3

20/10/2011

Học

?Hãy quan sát và cho biết dữ diệu số nằm ở vị trí nào?
* HS: Dữ liệu kiểu số nằm căn thẳng lề phải.

?Hãy cho biết dữ liệu kí tự gồm có? – HS trả lời

* GV: Chiếu 1 trang màn hình về kiểu dữ liệu kí tự

VDU: Hôm nay, lớp 7A đi học môn tin thời gian 8h 30’

?Hãy nhận xét dữ liệu kiểu kí tự nằm ở vị trí nào trong ô?

* Gọi hai em lên nhập dữ liệu (Dữ liệu tùy ý) 

* HS: Thao tác
	4.  Dữ liệu trên trang tính:
 a) Dữ liệu số:
- Là các số từ:  0→9,  tỉ lệ phần trăm (%)

- Kiểu số được ngầm định căn thẳng lề phải trong ô tính.

 b) Dữ liệu kí tự:

 - Là dãy các chữ cái từ A → Z, a  → z.

 - Các chữ số từ 0  →  9

 - Các kí hiệu: . , ? \ / ? * > < } ], …

- Dữ liệu kí tự được ngầm định căn thẳng lề trái trong ô tính.


HOẠT ĐỘNG 3:  BÀI TẬP.
 Bài 2 SHK trang 18: 


Vai trò đặc biệt của thanh công thức là dùng để nhập dữ liệu, hiển thị công thức và sửa nội dung của ô tính.

 Bài 3 SHK trang 18: 


Trong 1 khối được chọn ô nào có nền màu trắng là ô được kích hoạt (có thể là 1 trong 4 ô ở 4 góc của khối được chọn), nghĩa là ô được chọn đầu tiên của khối.

 Bài 5 SHK trang 18: 


Nhìn vào trang tính ta có thể nhận biết được các ô chứa dữ liệu kiểu gì, nếu ta chưa định dạng vì các  kiếu dữ liệu đã được ngầm định trong ô.
E. CỦNG CỐ:


- Cần nắm vững cách chọn các đối tượng trên trang tính.


- Phân biệt được các kiểu dữ liệu.

F. DẶN DÒ:

- Về xem lại toàn bộ lí thuyết đã học ở bài 2, làm các bài tập còn lại ở SGK. Xem trước bài thực hành 2 để tiết sau học thực hành.


A. MỤC ĐÍCH, YÊU CẦU:


- Phân biệt được bảng tính, trang tính và các thành phần chính của trang tính.


- Mở và lưu bảng tnhs trên máy tính.

- Thực hiện được việc chọn các đối tương trên trang tính

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Hãy cho biết đau là trang tính, trang màn hình và chọn một khối từ B2:D7?


2) Chọn một khối ô tùy ý và cho biết trong khối ô đó ô nào đang được kích hoạt?


3) Hãy cho biết đâu là hộp tên, thanh công thức và vai trò của nó?


* BÀI MỚI:

	Hoạt động giáo viên 
	Hoạt động học sinh

	Câu 1: Mở bảng tính Excel

Câu 2: - Mở 1 tệp tin đã có trên đĩa.

- Mở thêm một bảng tính mới

Câu 3: Lưu bảng tính với tên khác “BAITH2”

Câu 4: - Tìm hiểu các thành phần chính của trang tính.

- Di chuyển đến các ô tính trên trang tính.

Câu 5:  Nhập dữ liệu vào các ô và quan sát sự thay đổi dữ liệu ở thanh công thức.

Câu 6:   Bài tập 2

* Chọn các đối tượng trên trang tính

* Nhận xét cách chọn có kết hợp giữ phím Ctrl

* Đến nhanh địa chỉ ô A50, H19, D70, C100
	Câu 1: Nháy đúp chuột vào biểu tượng Excel

Câu 2: - File → Open → chọn đường dẫn đến tệp tin cần mở →  chọn tệp tin cần →  Open

- C1) Nháy chọn nút lệnh New trên thanh công thức

   C2) File →  New

Câu 3:   B1) File → Save as

               B2) Chọn đường dẫn đên thư mục cần lưu → gõ tên tệp vào khung File name → chọn Save
Câu 4:   - HS nhận biết ô, hàng, cột, hộp tên, thanh công thức, tên hàng, tên cột,…

 - Di chuyển đến các ô khác nhau để nhận biết sự thay đổi địa chỉ ô – HS thực hành trực quan trên phần mềm Excel

Câu 5:   Nhập dữ liệu kiểu số, kí tự vào 8 ô tính sau đó lần lượt nháy chọn từng ô và quan sát dữ liệu trên thanh công thức sẽ thấy dữ liệu thay đổi tùy thuộc vào dữ liệu đã nhập trước đó.

Câu 6:   Bài tập 2

- Chọn 1 ô: Nháy chuột vào ô cần chọn

- Chọn 1 cột: Nháy chuột vào nút tên cột 
- Chọn 1 hang: Nháy chuột vào nút tên hàng

- Chọn 1 khối: Di chuyển chuột để chọn

- Chọn nhiều khối ô không liền kề: Chọn khối đầu  + Ctrl + lần lượt chọn các khối tiếp theo.

* Nhận xét: Khi chọn các đối tượng khác nhau không liền kề, ta giữ phím Ctrl kết hợp lần lượt chọn thì các đối tượng đó đều được chọn, còn nếu không giữ phím Ctrl thì chỉ khối ô vừa được chọn là được chọn.

* Nháy chuột vào hộp tên và gõ địa chỉ ô cần đến → gõ phím Enter


* GV:  - Nhận xét ưu khuyết trong quá trình thực hành của HS

    - Hướng dẫn HS thực hành, sửa sai (nếu có)

E. DẶN DÒ: Về nhà làm bài tập 3, 4 SGK trang 21 để tiết sau thực hành tiếp.

A. MỤC ĐÍCH, YÊU CẦU:


- Phân biệt và nhập được một số kiểu dữ liệu khác nhau vào ô tính..

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Mở bảng tính Excel và đến ô B25 sau đó về lại ô A1 bằng ba cách?



+ Di chuyển thanh cuộn dọc để chọn.



+ Nháy vào hộp tên để chọn.



+ Gõ phím F5 để chọn


2) Nhập dữ liệu vào các địa chỉ sau?  Và nhận xét dữ liệu trong các ô đó

	A
	B
	C
	D
	E

	Họ và tên
	1567Ha
	3456
	25/9/2010
	Hôm 13/7/2010



* BÀI MỚI:

	Hoạt động giáo viên 
	Hoạt động học sinh

	Bài tập 3:
Mở bảng tính Excel

Bài tập 4:

Lập bảng theo dõi thể lực HS

?Hãy cho biết kiếu dữ liệu có trong địa chỉ ô.

* Vì sao em nhận biết được các kiểu dữ liệu có trong địa chỉ ô?

* Thoát khỏi Excel
	Bài tập 3:
* Mở bảng tính mới:

Nháy đúp chuột vào biểu tượng Excel trên màn hình nền

* Mở bảng tính “BAITH2” đã lưu trên đĩa.

B1) Nháy chọn nút lệnh [image: image5.bmp] Open trên thanh công cụ

B2) Mở ổ đĩa D → mở thư mục “LOP7” → chọn tệp “BAITH2” 

Bài tập 4:

A

B

C

D

E

1   DANH SÁCH LỚP EM

2

STT

Họ và tên

Năm sinh

Chiều cao (m)

Cân nặng
3

- Nhập vào danh sách 15 em
- Lưu tệp tin: B1) File → Save

                      B2) Chọn đường dẫn để lưu  → gõ tên tệp vào khung File name  →  chọn Save

* Địa chỉ ô của hàng 1, 2  và cột B là dữ liệu kí tự các ô còn lại chứa dữ liệu kiểu số

* Nêu chưa có sự can thiệp của định dạng thì những ô có dữ liệu căn thẳng lề trái là ô chứa dữ liệu là kí tự, còn căn thẳng lề phải là ô chứa dữ liệu là số
* Nháy chọn nút Close trên thanh tiêu đề


* GV: - Nhận xét ưu khuyết trong quá trình thực hành của HS


    - Hướng dẫn HS thực hành, sửa sai (nếu có)

E. DẶN DÒ:   -Về nhà tập nhập dữ liệu vào các ô tính.




- Xem trước bài “Luyện gõ phím bằng Typing Test” để tiết sau học


A. MỤC ĐÍCH, YÊU CẦU: 

- Hiểu công dụng và ý nghĩa của phần mềm.

- Biết cách khởi động và thoát khỏi phần mềm.


- Ôn luyện gõ phím

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Mở tệp “BAITH2” và chọn 1 hàng, 1 cột, 1 khối ô, nhiều khối ô không liền kề.


2) Nhập dữ liệu vào 3 ô sao cho có dữ liệu kí tự, dữ liệu số (dữ liệu tùy ý).


* BÀI MỚI:


* HOẠT ĐỘNG 1: Giới thiệu.

  Ở lớp 6 các em đã học luyện gõ phím bằng phần mềm Mario. Để gõ phím nhanh ta luyện như thế nào?

* HS: Luyện gõ bằng mười ngón.

?Có phần mềm nào khác hỗ trợ luyện gõ phím nữa không?

* HS: Có rất nhiều phần mềm hỗ trợ công việc luyện gõ phím.

* GV: Đúng vậy ở lớp 7 các em sẽ được học phần mềm mớ đó là Typing Test đây cũng là một trong các phần mềm dùng hỗ trợ việc luyện gõ phím nhanh. Vậy sử dụng phần mềm này như thế nào ta tìm hiểu bài mới.


* HOẠT ĐÔNG 2: Giới thiệu phần mềm

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Để luyện gõ phím ta cần hiểu đó là phần mềm gì?

?Để luyện gõ được với phần mềm đầu tiên ta phải làm gì? – HS: Khởi động phần mềm.

?Nêu các cách khởi động phần mềm mà em biết?

* HS: Trả lời

* GV: Thao tác – HS quan sát

* Chuyển sang màn hình khác → bắt đầu vào màn hình trò chơi → xuất hiện 4 cửa sổ → ta lựa chọn trò chơi từ dễ đến → khó
* GV: Hướng dẫn để HS rõ → HS nghe

Ví dụ: Để luyênj gõ bằng trò chơi đám mây, ta phải nhìn nhanh chữ cái ở dưới đám mây mà gõ, gõ xong phải gõ phím cách (Space) hoặc gõ Enter để sang đám mây khác.
* Gọi 3 em lên thao tác → HS thao tác

* Chú ý: - Trò chơi bóng mây (Bubbles) phải quan sát nhanh chữ cái thường hoặc hoa để gõ cho chính xá chữ thường hoặc chữ hoa

 - Để hủy trò chơi nào ta nháy vào nút Cancel

* Gọi 1 em thao tác gõ trò chơi Wordtris → HS thao tác

* Chú ý: Gõ nhanh các từ có trên thanh ngang để thanh ngang không thể rơi xuống đáy khung.
	1. Giới thiệu phần mềm:
  Typing Test là phần mềm hỗ trợ việc luyện gõ nhanh các phím bằng cách thông qua các trò chơi để luyện gõ.
2. Khởi động:

B1) Nháy đúp chuột vào biểu tượng  Typing Test trên màn hình nền.

 B2) Gõ tên em vào khung Enter Your name

 B3) Nháy chuột vào nút  > → Yes

 B4) Chon Warm up games

* Chọn thời gian luyện gõ ở khung Duration

B5) Lựa chọn trò chơi

- Clouds (cờ lao): Trò chơi đám mây

-  Wordtris (guộc trít): Gõ chữ cái nhanh
- Bubbles (bớp bờ): Trò chơi bong bóng

- abc: Gõ vòng tròn theo bảng chữ cái

* Lựa chọn 1 trong 4 trò chơi từ dễ đến khó: abc, Clouds, Bubbles, Wordtris → nháy vào nút  > 

B6)   >  Để sang màn hình tiếp theo

* Xong mỗi thao tác luyện gõ ta phải gõ phím Space để sang gõ tiếp.



	HOẠT ĐỘNG 3: Tìm hiểu cách thoát khỏi phần mềm

	?Khi luyện gõ xong ta phải làm gì? → HS thoát khỏi màn hình.

?Nêu các cách thoát khỏi phần mềm mà em biết → HS trả lời.
	4. Thoát khỏi phần mềm:

C1) Nháy vào nút Close 

C2: File → Exit

C3) Alt + F4


E. CỦNG CỐ: - Cần hiểu phần mềm Typing test là phần mềm dùng để luyện gõ phím nhanh.

- Biết cách khởi động vào luyện gõ và thoát khỏi phần mềm.

F. DẶN DÒ: - Về nhà tập luyện gõ phím nhanh với phần mềm Typing test để tiến sau thực hành luyện gõ phím.


A. MỤC ĐÍCH, YÊU CẦU: 

- Luyện tập gõ phím bằng cách thông qua các trò chơi: abc, Bubbles để luyện gõ phím. Từ đó HS hiểu và rèn luyện được kĩ năng gõ phím nhanh và chính xác.
B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính để luyện gõ phím
C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động phần mềm Typing test.


2) Vào luyện gõ trò chơi bóng mây (Bubbles).


* BÀI MỚI:

HS học luyện gõ phím bằng 10 ngón thông qua các trò chơi để học gõ.

CÂU 1: Khởi động phần mềm Typing test và vào tập gõ bằng trò chơi Bubbles
B1) Nháy đúp chuột vào biểu tượng Typing test trên màn hình nền

B2) Gõ tên em vào khung Enter Your name 

Chọn Yes

  * Nếu chưa có tên thì gõ tên, nếu đã có tên rồi thì chỉ việc chọn tên → Enter

B3) Lựa chọn thời gian gõ ở Duration 

B4) Chọn Warm up Games
B5)   >  Bubbles để vào luyện gõ

B6) Luyện gõ phím bằng cách quan sát nhanh chữ cái nằm trong bong bóng để gõ.

* Chú ý: Gõ đúng chữ thường, chữ hoa

B7)  > Kết thúc trò chơi và xem kết quả đạt được  >  quay về lựa chọn trò chơi khác.

* HS luyện gõ trò chơi này 10 lần.
CÂU 2: Vào luyện gõ phím bằng trò chơi ABC (Bảng chữ cái)

HS: Luyện gõ 10 lần trò chơi này.

B1) Nháy vào nút  >  của khung ABC →  >

B2) Luyện gõ phím theo các kí tự ở vòng tròn.

B3)  >  Xem kết quả

B4)   >  Để luyện gõ lại

* HS: Luyện gõ hai trò chơi này trong thời gian 40 phút.

CÂU 3:  Thoát khỏi phần mềm gõ tổ hợp phím Alt + F4

* GV:  - Hướng dẫn học sinh thực hành, gõ đúng, tư thế ngồi gõ đúng, cách đặt tay trên bàn phím, sửa sai (nếu có)



  - Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ: - Về nhà tập luyện gõ phím bằng phần mềm Typing test




 - Tập luyện gõ phím bằng cách thông qua hai trò chơi Clouds, Wordtris để tiết sau thực hành.


A. MỤC ĐÍCH, YÊU CẦU: 

- Luyện tập gõ phím bằng cách thông qua các trò chơi: Clouds và Wordtris để luyện gõ. 
- Từ đó HS hiểu và rèn luyện được kĩ năng gõ phím nhanh, chính xác. 
B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính để luyện gõ phím

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động phần mềm Typing test và vào bài luyện gõ bằng trò chơi ABC


* BÀI MỚI:

CÂU 1:  KhỞI động phần mềm Typing test  và vào luyện gõ bằng trò chơi Clouds (đám mây)

B1) B1) Nháy đúp chuột vào biểu tượng Typing test trên màn hình nền

B2) Gõ tên em vào khung Enter Your name 

Chọn Yes

  * Nếu chưa có tên thì gõ tên, nếu đã có tên rồi thì chỉ việc chọn tên → Enter

B3) Lựa chọn thời gian gõ ở Duration 

B4) Chọn Warm up Games

B5)   >  Clouds để vào luyện gõ

B6) Luyện gõ phím bằng cách quan sát nhanh các chữ cái nằm bên dưới đám mây để luyện gõ.

* Chú ý: Gõ đúng chữ thường, chữ hoa

B7)  > Kết thúc trò chơi và xem kết quả đạt được  >  quay về lựa chọn trò chơi khác.

* HS: -  Chú ý chữ thường, chữ hoa, luyện gõ trò chơi này 20 phút

    - Gõ xong các kí tự ở dưới đám mây phải gõ phím cách (Space) để chuyển nhanh sang bóng mây khác. 

B8) >  Kết thúc gõ và xem kết quả đạt được. >  Về lại cửa sổ chọn trò chơi

CÂU 2: Vào gõ phím nhanh bằng trò chơi Wordtris.
B1) Nháy chuột vào nút  >  của Wordtris → >
B2) Luyện gõ theo các kí tự ở thanh ngang

 * Chú ý: Gõ nhanh xong các kí tự ở thanh ngang phải gõ phím Space, không để thanh ngang rơi xuống đáy khung

B3)   >  Kết thúc luyện gõ và xem kết quả đạt được  → >  quay về cửa sổ chọn trò chơi khác

* HS luyện gõ bài này 20 phút.

* GV: 
- Hướng dẫn HS thực hành, sửa sai (nếu có).



- Nhận xét ưu khuyết trong quá trình thực hành của HS.

E. DẶN DÒ: 

  Về nhà tập luyện gõ phím bằng phần mềm Typing Test cho thành thạo.


A. MỤC ĐÍCH, YÊU CẦU: HS cần thao tác được

- Luyện tập gõ phím bằng cách thông qua các trò chơi: ABC, Bubbles, Clouds và Wordtris để luyện gõ. 

- Từ đó HS hiểu và rèn luyện được kĩ năng gõ phím nhanh, chính xác. 

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính để luyện gõ phím

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động phần mềm Typing test và vào bài luyện gõ bằng trò chơi Bubbles (đám mây).


2) Chọn trò chơi Wordtris (Gõ từ nhanh)


* BÀI MỚI:

CÂU 1: HS luyện gõ phím nhanh bằng trò chơi ABC → HS luyện gõ trong 8 phút.
CÂU 2: HS luyện phím nhanh bằng trò chơi Bubbles (bớp bờ)→ HS luyện gõ trong 10 phút.

CÂU 3: HS luyện phím nhanh bằng trò chơi Clouds (cờ lao) → HS luyện gõ trong 10 phút.

CÂU 4: HS luyện phím nhanh bằng trò chơi Wordtris (guộc trít) → HS luyện gõ trong 10 phút.

* Luyện gõ nhanh toàn bài 4 phút

* GV:  - Hướng dẫn HS thực hành, sửa sai (nếu có).

- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ: 

- Về nhà tập luyện gõ phím bằng phần mềm Typing test cho thành thạo.


- Chuẩn bị bài mới bài 3: “Thực hiện tính toán trên trang tính” để tiết sau học.

A. MỤC ĐÍCH, YÊU CẦU: HS biết

- Nhập công thức vào ô tính.

- Viết đúng được các công thức tính toán theo các kí hiệu phép toán của bảng tính.

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động Excel và nhập dữ liệu tùy ý vào ô tính.


2) Chọn khối ô và cho biết ô nào đang được kích hoạt?.


* BÀI MỚI:


* HOẠT ĐỘNG 1: Giới thiệu.

  Bảng tính Excel cung cấp các công cụ tính toán có tính năng hỗ trợ mạnh. Nhưng để tính toán được trong Excel ta cần phải nhập công thức theo qui định của bảng tính.
  Vậy nhập công thức như thế nào cho đúng? Để hiểu rõ vấn đề này ta tìm hiểu bài mới.


* HOẠT ĐÔNG 2: Tìm hiểu cách sử dụng công thức để tính toán.
	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Các em đã biết cách nhập dữ liệu vào ô tính.

?Vậy bảng tính còn cho phép ta thực hiện điều gì? – HS trả lời còn cho phép tính toán

?Hãy cho biết các phép toán thường sử dụng trong toán học?

* HS: Phép toán +, -, x, :

* GV: ở trang tính cũng thực hiện các phép toán đó để tính toán, nhưng cách viết lại có phép toán viết khác

?Hãy cho biết cách viết các phép toán trên trang tính?

* HS: Trả lời +, -, *, /, ^,

* GV: Ở trang tính ta sử dụng các kí hiệu ở bàn phím thay thế phép toán.

* GV: Thao tác mẫu – HS quan sát.

* Gọi một em thao tác lại – HS thao tác.

?Khi tính toán một biểu thức các em phải thực hiện theo một thứ tự nào?

* HS: Thực hiện trong ngoặc trước, tiếp đến nhân, chia,cuối cùng là cộng, trừ.
* GV: chiếu cách thực hiện phép toán trên trang tính – HS quan sát.

* Gọi ba em lên viết phép toán trên bảng và một em lên nhập phép toán trên máy tính – HS thao tác.

* GV: Nhập biểu thức =5+12-7 vào ô A2

?Hãy quan sát ô tính và nhận xét – HS có dấu bằng trước biểu thức.

* GV: Enter – HS quan sát ô tính và nhận xét 

* HS: lúc này ô tính không còn thấy biểu thức nữa mà thay vào đó là kết quả đã được tính toán.
	1. Sử dụng công thức để tính toán:

* Các kí hiệu dùng cho các phép toán:

  Cộng (+), trừ (- ),  nhân (*), chia (/), lũy thừa (^ ),  phần trăm (%).

- Cách thực hiện phép toán: Các phép toán trong ngoặc thực hiện trước → nâng lên lũy thừa → *, /, cuối cùng là +, -

	HOẠT ĐỘNG 3: Tìm hiểu cách nhập công thức

	* GV: Để thực hiện tính toán trên trang tính thì khi nhập biếu thức vào ô tính trước tiên ta phải nhập dấu bằng trước tiếp đến mới nhập dữ liệu.

Ví dụ: =(15+6)*3+(12+8)/2+3^2

* HS: Quan sát

* GV: Gõ phím Enter, hãy nhận xét ô tính?

* HS: Kết quả tính toán hiện ra.

* GV: Để thực hiện được tính toán các em cần thực hiện theo các bước sau

* Gọi bốn em lên nhập biểu thức và cho biết kết quả tính được.

- { [5 + 10(6-4+9)+7]-9:5}
- 12:6.4+3x2

- (15:5)42 + 15

- 6+8.9-12:6-9+20

* HS: thao tác
	2. Nhập công thức:

B1) Nháy chọn ô cần nhập công thức.

B2) Nhập dấu =

B3) Nhập biểu thức cần → gõ Enter

B4) Xem kết quả tính toán

 - Kết quả sẽ hiển thị ở ô nhập công thức.

 - Công thức được hiển thị trên thanh công thức.


E. CỦNG CỐ: 

- HS cần nắm vững các kí hiệu phép toán *, /, ^, %.


- Hiểu và biết cách nhập công thức bắt đầu bằng dấu bằng (=).


- Thực hiện tính toán được một số biểu thức đơn giản.

F. DẶN DÒ: 


- Về nhà lấy sách số học ra tập nhập và tính toán các phép toán trong sách giáo khoa trên trang tính.


- Làm các bài tập 1, 2, 3, 4 SGK trang 24


- Chuẩn bị bài mới bài 3 (tt) phần 3 để tiết sau học.


A. MỤC ĐÍCH, YÊU CẦU: HS biết

- Viết đúng được các công thức tính toán theo các kí hiệu phép toán.

- Biết cách sử dụng địa chỉ ô tính trong công thức.
B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Hãy nhập biểu thức sau theo công thức vào ô tính: (15+5)2 –(30-5)+42(40+5).

2) Nhập các giá trị sau vào địa chỉ ô

	Ô A2
	B2
	C3
	D3
	H4
	E4
	F1
	G1

	15
	5
	7
	30
	5
	4
	40
	5



* BÀI MỚI:

* HOẠT ĐÔNG 1: Tìm hiểu cách sử dụng địa chỉ ô trong công thức.

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: - Chiếu một bài mẫu trong đó có dữ liệu kiểu số, ô tính kết quả được nhập theo điạ chỉ ô – HS quan sát.
       - Ta không chỉ nhập biểu thức cụ thể giá trị mà có thể thông qua địa chỉ ô để nhận dữ liệu cho việc tính toán

       - GV thao tác mâuc – HS quan sát

* Gọi hai em thao tác – HS thao tác

* GV: Để thuận tiện cho việc chỉnh sửa dữ liệu trong ô tính, khi nhập công thức người ta sử dụng địa chỉ ô để thay thế.
* GV cho HS quan sát dữ liệu vừa nhập ở kiểm tra bài cũ và dữ liệu ở bài mẫu – HS quan sát.

* GV: Khi ta nhập dữ liệu vào ô tính thì dữ liệu đó sẽ được lưu ở ô tính đó.

* GV:  Thao tac nhập công thức – HS quan sát thanh công thức.

?Nếu ta đang nhập công thức hoặc dữ liệu thì thanh công thức có dạng như thế nào? – HS trả lời

* Ví dụ 2: GV thao tác theo hai cách nhập công thức.

C1  =Sum(A1:E2)/10  ( Kết quả = 240,808

C2  =(A1+C1+Đ1+A2+B2+D2+E2)/10

* HS: Quan sát

?Nhận xét hai cách nhập? 

*HS: Kết quả tính toán là như nhau, xong C1 nhập nhanh lại chính xác hơn

* Cũng ví dụ 2 GV nhập theo công thức 

= (2156+40+15,72+98+56+23+19,36)/10 ( 240,808

?So sánh kết quả - HS trả lời Kết quả như nhau.

* GV: Thay đôi dữ liệu ở ô tính.

?Hãy so sánh kết quả ở ba cách nhập tính toán ở trên

* HS: Kết quả khác nhau.

* GV: Nhập một dãy số sao cho dãy số lớn mà địa chỉ ô tính đó không chứa hết – HS quan sát.

?Hãy cho biết địa chỉ ô này như thế nào?

* HS: Địa chỉ có dạng ##########.

* GV: Nếu các em nhìn thấy ô tính có dạng ###### nghĩa là dữ liệu số quá dài nên không hiển thị hết, ta chỉ việc nháy đúp chuụot tại nút tên cột.
* Gọi bốn em thao tác – HS thao tác.

* Khi nhập dữ liệu đôi khi có sai sót hoặc muốn sửa chữa dữ liệu khác ta phải chính sửa dữ liệu.

?Chỉnh sửa bằng cách nào? – HS trả lời.

* GV thao tác mẫu – HS quan sát.

?Nêu cách chỉnh sửa dữ liệu? – HS trả lời

* Gọi hai em thao tác – HS thao tác

* GV: Nháy chuột vào một ô có dữ liệu và gõ dữ liệu mới. – HS quan sát.
?Nhận xét ô tính?

* HS: Dữ liệu cữ bị xóa sạch thay vào đó là dữ liệu mới vừa nhập.
	3. Sử dụng địa chỉ ô trong công thức:

- Nếu nhập dữ liệu vào ô tính thì thanh công thức có dạng.
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 * Trong đó:  + X (Cancel): Hủy dữ liệu vừa nhập.

  + (((Enter): Kết thúc thao tác nhập.

  + fx: Chọn hàm.
 - Để kết quả tính toán được cập nhật tự động, chính xác ta nên sử dụng địa chỉ ô thay cho dữ liệu.

Ví dụ: =A1+B2

* Chú ý: - Nếu dữ liệu là số nhập vào ô quá dài thì khi hiển thị ô sẽ có dạng #######, chỉ việc nháy đúp chuột vào ô đó sẽ hiển thị đầy đủ.

* Chỉnh sửa dữ liệu trong ô tính:

B1) Nháy chọn ô cần chỉnh sửa

B2) C1: Nháy chuột lên thanh công thức → sửa → gõ phím Enter

  C2: Gõ F2 → sửa → Gõ phím Enter

* Chú ý: Nếu muốn nhập dữ liệu mới vào ô đã có dữ liệu ta chỉ việc chọn ô đó và nhập dữ liệu mới, dữ liệu cũ lập tức bị xóa sạch.


* HOẠT ĐỘNG 2: Bài tập
 1) Bạn Hằng đã nhập thiếu dấu (=) ở công thức.

 3) Lợi ích của việc sử dụng địa chỉ ô tính trong công thức là cập nhật tự động kết quả tính toán.

 4) Câu C đúng.

E. CỦNG CỐ: 


Nắm vững cách nhập công thức bằng hai cách đó là nhập trực tiếp giá trị và nhập theo địa chỉ ô.

F. DẶN DÒ:


- Về nhà nhập dữ liệu số vào ô tính (dữ liệu tùy ý) → thực hiện tính toán theo địa chỉ ô.


- Xem trước bài thực hành 3 để tiết sau thực hành.


- Đem SGK số học lớp 7 để lấy dữ liệu tính toán.

A. MỤC ĐÍCH, YÊU CẦU: HS cần thao tác được

- Biết nhập và sử dụng công thức trên trang tính 

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính 

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7,  sách GK số học 7, phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Nhập dữ liệu vào các ô 

	A1
	B2
	C1
	D2

	5
	8
	10
	15


  ?Hãy nhập công thức để tính toán tổng giá trị của các ô theo hai dạng: 


+ Nhập giá trị trực tiếp vào công thức.


+ Nhập giá trị theo địa chỉ ô vào công thức


2) – So sánh kết quả hai ô tính vừa nhập công thức.

    - Sửa dữ liệu (tùy ý) vào địa chỉ các ô trên → So sánh kết quả của hai ô nhập công thức.


* BÀI MỚI:

CÂU 1: Khởi động bảng tính Excel: Nháy đúp chuột vào biểu tượng Excel trên màn hình nền
CÂU 2: Làm bài tập 1, 2 SGK trang 25, 26.


* Bài tập 1:

	
	A
	B
	C
	D
	E

	1
	=20+15
	=20-15
	=20*5
	=20/5
	=20^5

	2
	=20+15*4
	=(20+15)*4
	=(20-15)*4
	=20-(15*4)
	

	3
	=144/6-3*5
	=144/(6-3)*5
	=(144/6-3)*5
	=144/(6+3)*5
	

	4
	=15^2/4
	=(2+7)^2/7
	=(32-7)^2-(6+3)^3
	
	


 * HS thao tác trên máy tính- GV hướng dẫn HS nhập đúng công thức → sửa sai (nếu có).

* Bài tập 2:  Tạo bảng tính và nhập công thức.

 B1: Mở trang tính mới (Sheet 2) để làm

 B2: Nhập dữ liệu vào ô tính sau đó tính toán giá trị  theo địa chỉ ô

	
	A
	B
	C
	D
	E
	F
	G
	H

	1
	5
	
	
	=A1+5
	=A1*5
	=A1+B2
	=A1*B2
	=(A1+B2)*C4

	2
	
	8
	
	=A1*C4
	=B2-A1
	=(A1+B2)-C4
	=(A1+B2)/C4
	=B2^A1-C4

	3
	
	
	
	=A1*C4
	=(C4-A1)/B2
	=(A1+B2)/2
	=(B2+C4)/2
	=(A1+B2+C4)/3

	4
	
	
	12
	
	
	
	
	


* GV: - Hướng dẫn HS thao tác nhập công thức theo địa chỉ ô cho đúng → sửa sai (nếu có)

   - Nhận xét ưu khuyết trong quá trình thực hành của HS.

E. DẶN DÒ: Về xem tiếp bài thực hành 3 bài 3, 4 SGK trang 26, 27 để tiết sau thực hành tiếp


A. MỤC ĐÍCH, YÊU CẦU: 

- HS hiểu địa chỉ tương đối, địa chỉ tuyệt đối.

- Biết nhập và sửa công thức trên trang tính. 

B. PHƯƠNG PHÁP: 

 
- Học sinh thực hành trực quan trên máy tính 

C. PHƯƠNG TIỆN DẠY HỌC:

 
- SGK tin 7,  phòng máy tính.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Nhập dữ liệu vào các ô sau và cho biết kết quả  như thế nào? Nhìn vào đâu mà em biết ô nào nhập công thức, ô nào nhập dữ liệu?

	A1
	B2
	C1
	D2

	=55-40*3^2
	(24*5)^2-126*
	125
	=A1+C1


  
* BÀI MỚI:


* GV: Để làm được bài 3 các em phải hiểu được thế nào là địa chỉ tương đối, địa chỉ tuyệt đối.


a) Tuyệt đối cột, tuyệt đối dòng: Khi sao chép địa chỉ ô được tính toán ở công thức không thay đổi, ta phải tuyệt đối cột, tuyệt đối dòng của ô chứa dữ liệu số cần cho tính toán. Để tuyệt đối ô tính ta chỉ việc gõ F4 1 lần


Ví dụ: Tuyệt đối ô B2 → Gõ F4 một lần (  =$B$1


b) Tuyệt đối cột, tương đối dòng: 

 - Khi sao chép địa chỉ cột không thay đổi, địa chỉ dòng thay đổi.

 - Ta gõ F4 ba lần → Ví dụ: B1  (  =$B1


c) Tương đối cột, tuyệt đối dòng: Khi sao chép địa chỉ cột thay đổi địa chỉ dòng không thay đổi → gõ F4 hai lần 
Ví dụ: B1 (  =B$1


* Bài tập 3: Thực hành lập và sử dụng công thức tính lãi xuất tiền gửi tiết kiệm không kì hạn.
	
	A
	B
	C
	D

	1
	Tiền gửi
	5.000.000
	Tháng
	Số tiền trong sổ

	2
	Lãi xuất
	0,3%
	1
	=($B$1*$B$2)+$B$1

	3
	
	
	2
	=($B$1*$B$2)+D2

	4
	
	
	3
	* Từ tháng 3 đến tháng 12 ta chỉ việc sao chép công thức của ô D3 bằng cách đưa chuột vào ô vuông màu đen góc dưới bên phải ô D3 sao cho chuột có dấu cộng (+) → nháy đúp chuột để sao chép

	:
	
	
	12
	



* Bài tập 4: Lập bảng tính và sử dụng công thức.
 B1) Mở bảng tính mới Nháy chọn nút lệnh New trên thanh công cụ

 B2) Lập bảng điểm của em

	
	A
	B
	C
	D
	E
	F
	G
	H
	

	1
	BẢNG ĐIỂM CỦA EM
	
	
	
	

	2
	TT
	Môn
	ĐM
	15’
	TH
	KT1tiết
	HK
	ĐTB

	3
	1
	Toán
	
	
	
	
	
	
	=(SUM(C3:E3)+(F3+G3)*2+H3*3)/10

	4
	2
	Tin
	
	
	
	
	
	
	

	:
	:
	:
	
	
	
	
	
	
	



* GV: - Hướng dẫn HS hiểu rõ địa chỉ ô tương đối, địa chỉ ô tuyệt đối.


       - Nhận xét ưu khuyết trong quá trình thực hành của HS → sửa sai (nếu có)


E. DẶN DÒ: Về xem trước bài 4 “Sử dụng các hàm để tính toán”, phần 1, 2 SGK trang 28, 29 để tiết sau học.

A. MỤC ĐÍCH, YÊU CẦU: 

- Biết cách sử dụng một số hàm cơ bản như: Hàm tính tổng (Sum), hàm tính trung bình cộng (Average), hàm tìm giá trị lớn nhất (Max), hàm tìm giá trị nhỏ nhất (Min).

- Viết đúng cú pháp các hàm.

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Lên tính biểu thức sau: a) 12.32 +6 - 4 + 3/2







  b) (5 + 2 )2 +10 – 1/5




c) 3/2 + 53 . 22 – ( 3 + 2)2 + 3 + 10 + 105 +17 + 9 +25 + 41


2) Chọn khối ô và cho biết ô nào đang được kích hoạt?.


* BÀI MỚI:


* HOẠT ĐỘNG 1: Giới thiệu.

   Các em đã được biết trang tính cho phép nhập dữ liệu vào các ô tính và tính toán bằng cách nhập công thức trực tiếp hoặc tính toán theo địa chỉ ô tính.
?Hãy quan sát bài cú câu C để tính toán được phép toán này các em cần mấy phép toán cộng?

* HS: Cần 9 phép toán cộng.

?Vậy có cách nào giúp cho việc tính toán nhanh, đơn giản hơn lại chính xác cao. Bảng tính điện tử cho phép ta sử dụng hàm để thay các phép toán.

* Sử dụng hàm như thế nào? Ta tìm hiểu bài mới.


* HOẠT ĐÔNG 2: Tìm hiểu cách sử dụng hàm trong chương trình bảng tính.

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Ghi phép toán lên bảng: 10+ 3+ 6 + 20 + 150

* Gọi một HS lên nhập phép toán này vào một ô của trang tính – HS thao tác.

* Gọi một HS lên nhập các giá trị sau vào các ô tính: 200, 17, 6, 4, 7, 15, 30, 100, 90, 76, 42, 18 – HS thao tác.

* Gọi một HS lên tính tổng giá trị của số liệu vừa nhập  – HS thao tác.

* Gọi một HS lên tính trung bình cộng của các giá trị trên – HS thao tác.
* GV: Giả sử cô có 2.500 ô chứa dữ liệu nếu tính toán như thế sẽ như thế nào?

* HS: Nếu lần lượt nhập từng địa chỉ ô sẽ rất dài, khó khăn, dễ nhầm lẫn và có khi lại bị sai sót.

* GV: - Để tính toán nhanh lại không bị nhầm lẫn, bảng tính cho phép ta sử dụng các hàm để tính toán thay cho các phép toán.
       - Sử dụng các ô tính có chứa dữ liệu đã nhập ở trên.

       - GV thao tác tính tổng của các ô từ A1 đến E5

=Sum(A1:E5) – HS quan sát và nhận xét kết quả

* HS: Kết quả như nhập công thức nhưng cách viết lại nhanh và chính xác hơn.

* Gọi một HS thao tác tính tổng của các ô từ A1 đến F1- HS thao tác.
* GV: Nếu tính trung bình cộng của ba số: 6, 10, 9 các em tính như thế nào?

* HS: ta sẽ cộng ba số lại và chia cho ba (6 + 10 + 9)/3

* GV: ta có thể sử dụng hàm thay cho các phép toán cộng và chia đó là hàm Average.
Ví dụ: có bảng dữ liệu sau

A

B

C

D

1

15

Hôm

10

7

2

12

9

Đi

3

17

6

8

4

Quê

30

6

5

4

5

* Gọi hai HS lên sử dụng hàm Sum để tímh tổng

 + Một tính tổng theo địa chỉ ô

 + Một tính tổng theo khối ô từ A1 đến D5 – HS thao tác

* GV: Chốt lại

* GV: Từ bảng dữ liệu trên ta có thể dễ dàng tính tổng, tính trung bình cộng của các giá trị đó nhanh chóng bằng cách sử dụng  hàm để tính.
	1. Hàm trong chương trình bảng tính:

* Cách viết:

=Tên hàm(tham số của hàm)

* Chú ý: - Mỗi tham số được viết cách nhau bởi dấu phẩy (,).

VD: Tính tổng của các ô A1, A3, B1, C5

=Sum(A1,A3,B1,C5)

  - Nếu tham số là một khối ô liền kề thì ta chỉ việc viết địa chỉ ô đầu:địa chỉ ô cuối.

VD: Tính tổng của khối ô từ A1 đến G15

                =Sum(A1:G15)

- Hàm là công thức được định nghĩa sẵn của bảng tính.

- Hàm được sử dụng để tính toán theo công thức dễ dàng và nhanh chóng.

	HOẠT ĐỘNG 3: Tìm hiểu cách sử dụng hàm

	* GV: Để sử dụng hàm ta cần nhập hàm vào ô tính bằng cách nhập tương tự nhập công thức.
Ví dụ: =Average(A1:A10)

* Gọi một em lên nhập hàm tính trung bình cộng của các ô A1, C1, D1, B2, C2, A3

* HS: =Average(A1,C1,D1,B2,C2,A3)

              Tên hàm         Tham số

?Nêu cách bước thực hiện sử dụng hàm – HS trả lời


	2. Cách sử dụng hàm:
B1: Nháy chịn ô cần nhập hàm

B2: Gõ dấu =

B3: Nhập hàm

B4: Nhập tham số cho hàm (Nhập giá trị)

B5:  Gõ phím Enter để kết thúc



* HOẠT ĐỘNG 4: HS Lên máy thao tác
Cho bảng dữ liệu sau

	
	A
	B
	C
	D

	1
	25
	4
	9
	70

	2
	60
	45
	23
	6

	3
	105
	72
	51
	13

	4
	150
	250
	165
	5

	5
	201
	10
	95
	76


1. Tính tổng của từng hàng – HS lên máy thao tác
     =Sum(A1:D1) ;      =Sum(A2:D2) ;      =Sum(A3:D3) ;      =Sum(A4:D4) ;      =Sum(A5:D5) ; 

2. Tính trung bình cộng của từng hàng.

  =Average(A1:D1) ; =Average(A2:D2) ; =Average(A3:D3) ; =Average(A4:D4) ;  =Average(A5:D5); 

3. Tính tổng của khối ô từ A1 đế D5:      =Sum(A1:D5)

4. Tính trung bình cộng của khối ô từ A1:D5:    =Averege(A1:D5)

E. DẶN DÒ:  - Về nhà làm bài tập 1, 2 SGK trang 31




- Chuẩn bị bài mới: Xem tiếp bài 4 phần 3 để tiết sau học.


A. MỤC ĐÍCH, YÊU CẦU: 

- Biết cách sử dụng một số hàm cơ bản như: Hàm tính tổng (Sum), hàm tính trung bình cộng (Average), hàm tìm giá trị lớn nhất (Max), hàm tìm giá trị nhỏ nhất (Min).

- Sử dụng hàm để tính kết hợp các số và địa chỉ pp tính cũng như địa chỉ các khối ô trong công thức.

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Cho bảng dữ liệu sau






        1. Tính tổng giá trị dòng 1 và 2 bằng cách nhập trực tiếp giá trị.






=15+11+100+30+16+20






        2. Tính tổng giá trị dòng 1 và 2 bằng cách nhập theo địa chỉ ô.







=A1+B1+C1+A2+B2+C2)






         3. Tính trung bình cộng của khối ô







=(15+11+100+30+16+20+4+5+7+9+120+3)/12 

* BÀI MỚI:

* HOẠT ĐÔNG 1: Tìm hiểu một số hàm trong chương trình bảng tính.

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Để tiện cho việc tính toán nhanh lại chính xác, bảng tính cho phép sử dụng hàm thay các phép toán.
* GV: - Để tính toán nhanh các câu hỏi ở bài cũ ta thay các phép toán cộng, chia bằng hàm Sum, Average sẽ tính toán nhanh hơn rất nhiều.

   - GV thao tác mẫu – HS quan sát

* Gọi một em thao tác lại – HS thao tác

?Nêu các cách sử dụng hàm để tính tổng?- HS trả lời

* GV: Để tính trung bình cộng ta cũng thực hiện các cách như tính tổng.

?Để tính trung bình cộng ta sử dụng hàm nào?

* HS: Ta sử dụng hàm Average.

* Dựa vào bảng dữ liệu của bài cũ, gọi ba em lên thao tác mỗi em thực hiện một cách.
* HS: Thao tác.

?Nêu các cách sử dụng hàm để tính trung bình cộng?- HS trả lời

* GV: Hàm tính trung bình cộng nghĩa là Excel tự động cộng tất các các giá trị có trong các ô sau đó tự động chia cho tổng các giá trị.

* GV: Từ bảng dữ liệu trên GV thay đổi dữ liệu của một số ô (chỉnh lại bảng dữ liệu như sau


* Gọi lần lượt hai em lên tính tổng, tính trung bình cộng của khối ô từ A1 đến C4 – HS thao tác – Cả lớp quan sát.

?Hãy nhận xét giá trị khi tính toán?

* HS: Giá trị được tính toán với dữ liệu là số, không tính dữ liệu là kí tự.

?Hãy quan sát bảng dữ liệu hãy cho biết giá trị nào lớn nhất?  - HS: 150 là lớn nhất

?Làm thế nào để tìm nhanh địa chỉ ô có giá trị lớn nhất?

* HS: Ta sử dụng hàm Max để tìm giá trị lớn nhất.

* Gọi Hai HS lên thao tác – HS thao tác.

?Nêu các cách tìm giá trị lớn nhất? – HS trả lời.

* Tương tự để tìm giá trị nhỏ nhất ta là thế nào? – HS trả lời.

* Gọi một HS thao tác – HS thao tác
	3. Một số hàm trong chương trình bảng tính:
 a. Hàm tính tổng (SUM):

C1:   =Sum(Giá trị 1, giá trị2, ..,giá tri n)

C2:   =Sum(Địa chỉ ô 1, địa chỉ ô2,…, địa chỉ ô n)

 C3:  =Sum(Địa chỉ ô đầu:địa chỉ ô cuối)

b. Hàm tính trung bình cộng (Average):

 C1: =Average(Giá trị 1, giá trị2,..,giá tri n)

 C2: =Average(Địa chỉ ô 1, địa chỉ ô2,…, địa chỉ ô n)

 C3: =Average(Địa chỉ ô đầu:địa chỉ ô cuối)

* Chú ý: Khi tính toán Excel chỉ tính địa chỉ ô có chứa dữ liệu là số, còn các ô không chứa dữ liệu hoặc chứa dữ liệu là kí tự thì Excel sẽ bỏ qua không tính.
e. Hàm xác định giá trị lớn nhất (Max):

 C1: =Max(Giá trị 1, giá trị2,..,giá tri n)

 C2: =Max(Địa chỉ ô 1, địa chỉ ô2,…, địa chỉ ô n)

 C3: =Max(Địa chỉ ô đầu:địa chỉ ô cuối)

d. Hàm xác định giá trị nhỏ nhất (Min):

 C1: =Min(Giá trị 1, giá trị2,..,giá tri n)

 C2: =Min(Địa chỉ ô 1, địa chỉ ô2,…, địa chỉ ô n)

 C3: =Min(Địa chỉ ô đầu:địa chỉ ô cuối)




E. DẶN DÒ: 

- Về nhà làm bài tập 3 SGK trang 31.


- Tự làm thêm một số ví dụ với dữ liệu tùy ý bằng cách sử dụng bốn hàm vừa học.


- Chuẩn bị bài mới bài thực hành 4 để tiết sau thực hành.


A. MỤC ĐÍCH, YÊU CẦU:   - Biết nhập công thức và hàm vào ô tính.
- Biết sử dụng hàm Sum,Average, Max, Min để tính toán. 

B. PHƯƠNG PHÁP:     - Học sinh thực hành trực quan trên máy tính 
C. PHƯƠNG TIỆN DẠY HỌC:  - SGK tin 7,  phòng máy tính.
D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ:   1) Mở của sổ Excel và nhập dữ liệu vào các ô sau.
	
	A
	B
	C
	D
	E

	1
	9
	6
	7
	8
	

	2
	5
	10
	6
	8
	

	3
	7
	3
	5
	6
	


    a) Tính tổng của khối ô từ A1 để D3

    b) Tìm giá trị nhỏ nhất  của khối ô A1 đến D3

    c) Tính trung bình cộng của khối ô A1 đến D3  

* BÀI MỚI:    Bài 1: Lập trang tính và sử dụng công thức
1. Khởi động chương trình bảng tính. Nháy đúp chuột vào biểu tượng Excel trên màn hình nền.

2. Mở bài “BAITH1” đã lưu trong máy

* Yêu cầu HS mở đúng đường dẫn: D:\LOP7|BAITH1

a) Nhập điểm thi cho các môn theo minh họa ở hình 30 SGK trang 34
	
	A
	B
	C
	D
	E
	F
	G
	H
	I

	1
	BẢNG ĐIỂM LỚP 7A
	
	
	
	
	

	2
	TT
	Họ và tên
	Toán
	Lí
	Tin
	Văn
	Sử
	Địa
	ĐTB

	3
	1
	Lê Thi Na
	8
	7
	9
	5
	6
	7
	

	4
	:
	:
	
	
	
	
	
	
	



*  Yêu cầu: - HS nhập điểm cho 10 em.

  b) Sử dụng công thức để tính điểm trung bình cho các bạn trong lớp.

* Yêu cầu: - Nhập công thức tại cột I để tính ĐTB cho từng bạn.

        =(C3*2+D3+E3+F3*2+G3+H3)/8

Chỉ cần nhập hàm để tính cho một bạn đầu, sau đó sử dụng phương pháp sao chép để sao chép cho các bạn còn lại, bằng cách đưa chuột vào ô vuông màu đen nằm ở góc dưới bên phải ô và nháy đúp chuột để sao chép.
  c) Tính điểm trung bình của cả lớp và ghi vào ô cuối cùng của cột ĐTB  

=(I3+I4+I5+I6+…I12)/10
  d) Lưu bảng tính với tên “BAITH4” vào thư mục :”LOP7” ở ổ đĩa D

B1) File save as → mở ổ đĩa D → mở thư mục “LOP7” 

B2) Gõ tên tệp vào khung File name 


 Chọn Save

Bài 2: - Mở “BAITH2” đã lưu trên máy

Nháy chọn nút lệnh [image: image7.bmp] (Open) trên thanh công cụ → mở ổ đĩa D → mở thư mục “LOP7”  → chọn tệp “BAITH2” → Open.

- Tính chiều cao, cân nặng trung bình của các bạn.


+ Tính chiều cao trung bình:   =Average(D3:D12)


+ Tính cân nặng trung bình:  C1)   =Average(E3:E12)



C2) Sao chép công thức tính trung bình  chiều cao bằng cách đưa chuột vào ô vuông màu đen góc dưới bên phải ô D3 di chuyển chuột sang phải.
- Lưu dữ liệu vừa sửa vào bảng tính: Nháy chọn nút lệnh [image: image8.bmp] (Save) trên thanh công cụ.

* GV:  - Hướng dẫn HS thực hành → sửa sai (nếu có).

 
- Nhận xét ưu khuyết trong quá trình thực hành của HS

E. DẶN DÒ: Về nhà làm tiếp bài tập 3, 4 SGK trang 35 để tiết sau thực hành tiếp


A. MỤC ĐÍCH, YÊU CẦU:   

- Biết sử dụng hàm Sum,Average, Max, Min để tính toán. 

B. PHƯƠNG PHÁP:     - Học sinh thực hành trực quan trên máy tính 
C. PHƯƠNG TIỆN DẠY HỌC:  - SGK tin 7,  phòng máy tính.
D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ:   


1) Mở “BAITH4” và tìm điểm nhỏ nhất của các môn học.

2) Tính điểm trung bình của từng môn bằng cách sử dụng hàm để tính.


* BÀI MỚI:    
* Mở “BAITH4” đã lưu ở tiết trước: Nháy chọn nút lệnh [image: image9.bmp] (Open) trên thanh công cụ → mở ổ đĩa D → mở thư mục “LOP7”  → chọn tệp “BAITH4” → Open.

Bài tập 3: - Sử dụng bảng điểm đã lưu ở tiết trước ìa sử dụng hàm để tính ĐTB cho từng bạn, ĐTB cho cả lớp, sử dụng hàm Max, Min để tìm ĐTB lớn nhất, nhỏ nhất.

* Tính điểm trung bình cho từng bạn:  =Average(C3:H3,C3,F3) → sau đó sao chép công thức cho các bạn còn lại. (thêm C3 và F3 là môn văn, toán hệ số 2)

* Tính điểm trung bình cho cả lớp:  =Average(I3:I12) 


* Tìm ĐTB nhỏ nhất:   =Min(I3:I12)

* Tìm ĐTB lớn nhất:   =Max(I3:I12)

* Tìm điểm môn học nhỏ nhất:   =Min(C3:H12)

* Tìm điểm môn học lớn nhất:   =Max(C3:H12)

* So sánh kết quả vừa tính với kết quả tính ở tiết trước là như nhau, nhưng cách tính sau đơn giản hơn, chính xác hơn.

   - Lưu dữ liệu vừa chỉnh vào bảng tính:  Nháy chọn nút lệnh [image: image10.bmp] (Save) trên thanh công cụ.

BÀI TẬP 4: Lập trang tính và sử dụng hàm Sum để tính theo hình 31 SGK trang 35.
   * Yêu cầu: Mở trang tính 3 (Sheet3) và tọa bảng dữ liệu theo hình 31

	
	A
	B
	C
	D
	E

	1
	
	
	
	
	

	2
	Năm
	Nông nghiệp
	Công nghiệp
	Dịch vụ
	Tổng

	3
	2001
	1.640,31
	542,155
	1.049,45
	

	4
	:
	:
	:
	:
	



- Sử dụng hàm Sum để tính tổng cho từng ngành, cho năm.


=Sum(B3:D3) → Sao chép công thức tính cho các năm còn lại


=Sum(B3:B10) → Sao chép công thức tính cho các ngành còn lại


- Tính giá trị trung bình trong các năm  =Average(E3:E10)

- Lưu dữ liệu vừa chỉnh vào bảng tính:  Nháy chọn nút lệnh [image: image11.bmp] (Save) trên thanh công cụ.

* GV:  - Hướng dẫn học sinh thực hành → sửa sai (nếu có).

- Chú ý học sinh cách nhập hàm cho đúng.

- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ: 

- Về ôn lại toàn bộ lí thuyết đã học từ bài 1 đến bài 4.


- Làm các bài tập ở sách giáo khoa để tiết sau làm bài tập.


A. MỤC ĐÍCH, YÊU CẦU: 

- Giúp HS vận dụng lí thuyết đã học để giải một số bài tập và câu hỏi ở SGK, sách bài tập.

B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Mở “BAITH3” đã lưu trên máy và tính ĐTB của từng môn học.


2) Tìm ĐTB lớn nhất, nhỏ nhất.


* BÀI MỚI:

	Hoạt động giáo viên 
	Hoạt động học sinh

	Câu 1: Giả sử ô A1 đang được kích hoạt. Hãy cho biết cách nhanh nhất để chọn ô K70, A40
Câu 2: 

- Nháy chuột vào hộp tên và gõ A:A

  + gõ: A:C; B2:D6

  + Gõ 2:2; 2:4

  + A:A,A:C,2:2,2:4,B2:D6

Câu 3: 

Nê cách chọn đói tượng

Câu 4: 

Phát biểu nào sau là sai khi nói về lợi ích của chương trình bảng tính?

Câu 5: 

Vùng giao nhau giữa một cột và một hàng gọi là?

Câu 6: 

Địa chỉ ô được gọi như thế nào?

Câu 7: 

Cho biết chức năng của các hàm sau

 - Sum

 - Average

 - Max

 - Min

Câu 8: 

Cho biết ý nghĩa của kí hiệu sau ##

Câu 9: 

Khối ô C6:D9 có đồng nhất với khối ô D9:C6.

Câu 10: 

Phát biểu nào sau đâu là sai khi nói về bảng tính
	Câu 1: 

- Đến nhanh ô K70: Nháy chuột vào hộp tên gõ K70 → Gõ phím Enter.

- Đến nhanh ô A40: Nháy chuột vào hộp tên gõ A40 → Gõ phím Enter

Câu 2: 

- Chọn cột A,.

- Chọn cột A, B, C, chọn khối ô từ B2 đến D6

- Chọn dòng 2, chọn dòng 2, 3, 4

- Chọn nhiều khối ô: Cột A, cột A, B, C, dòng 2, dòng 2, 3, 4, khối ô từ B2 đến D6.

Câu 3: 

- Chon 1 ô: Nháy chuột vào ô cần chọn.
- Chọn 1 hàng: Nháy chuột vào nút tên hàng

- Chọn 1 cột: Nháy chuột vào nút tên cột.

- Chọn khối ô: Di chuyển chuột để chọn.

- Chọn nhiều khối ô không liền kề: Chọn khối đầu + giữ phím Ctrl + lần lượt chọn các khối tiếp theo

* Ô được chọn đầu tiên là ô được kích hoạt.

Câu 4: 

a. Việc tính toán được thực hiện tự động.

b. Có thể dễ dàng tạo biểu đồ.

c. Khi chỉnh sửa tự động cập nhất kết quả.

d. Bảng tính chỉ nhập được dữ liệu kiểu số.

Câu 5: 

Vùng giao nhau giữa một cột và một hàng gọi là ô tính

Câu 6: 

Địa chỉ ô được gọi tên cột trước, tên hàng sau
Câu 7: 

- Hàm tính tổng

- Hàm tính trung bình cộng

- Hàm tìm giá trị lớn nhất.

- Hàm tìm giá trị nhỏ nhất.

Câu 8:  Ô tính có độ rộng hẹp nên không hiển thị hết dữ liệu kiểu số có trong ô.

Câu 9: 

Khối ô C6:D9 không đồng nhất với khối ô D9:C6 vì khối ô C6:D9 có ô C6 được kích hoạt, còn khối ô D9:C6 có ô D9 được kích hoạt.

Câu 10: 

a. Chứa dữ liệu kí tự

b. Không chứa dữ liệu ảnh.

c. Chứa dữ liệu số
d. chứa dữ liệu thời gian


* GV: - Nhận xét độ bền kiến thức, thái độ làm bài của HS
E. DẶN DÒ: 

Về ôn tập lại toàn bộ lí thuyết đã học từ bài 1 đến bài 4 và làm các bài tập còn lại ở SGK, sách bài tập để tiết sau kiểm tra một tiết.
TIẾT 22: KIỂM TRA 1 TIẾT KÌ I

KIỂM TRA I TIẾT

Môn:  Tin Học Lớp 7

A. Mục tiêu đánh giá: 

    -   Về kiến thức:  

· Học sinh biết bảng tính là gì?, chức năng chủ yếu của các thành phần chính trong   bảng tính Excel.

· Biết được các thành phần chính và dữ liệu trên trang tính.

· Hiểu và vận dụng một số hàm tính tổng (SUM), tính trung bình cộng (AVERAGE), tìm giá trị lớn nhất, nhỏ nhất  trong trang tính.

    - Về kỹ năng:  Viêt đúng công thức và sử dụng một số hàm có sẵn.

    - Về thái độ:    Học sinh có thái độ học tập nghiêm túc, trung thực trong kiểm tra.
B. Yêu cầu của đề bài:   - Đề  kiểm tra thể hiện được các yêu cầu về mục tiêu đánh giá.

    


          - Đảm bảo yêu cầu phân loại được các đối tượng học sinh.

   


          - Đề in rõ, từ ngữ trong sáng,  không sai chính tả.

Trường THCS  Thủy An

Họ và tên :……………………………
Lớp          : ……………

KIỂM TRA 45’

MÔN : Tin Lớp 7

§iÓm 


               
 Lêi phª cña gi¸o viªn

	
	


 §Ò bµi:

A. Trắc nghiệm:(3đ)Khoanh tròn vào chữ cái ở đầu câu trả lời đúng:

C©u 1: Trong c¸c phÇn mÒm cã tªn sau, phÇn mÒm nµo lµ phÇn mÒm b¶ng tÝnh:


A. Microsoft Word
.



B. Microsoft Excel.


C. Microsoft Power Point.


D. Microsoft Access.

C©u 2: Th«ng tin ®­îc l­u d­íi d¹ng b¶ng cã ­u ®iÓm g×:


A. TÝnh to¸n nhanh chãng.
B. DÔ theo dâi, tÝnh to¸n nhanh chãng.


C. DÔ s¾p xÕp.


D. DÔ s¾p xÕp, DÔ theo dâi, tÝnh to¸n nhanh chãng.

C©u  3: C©u nµo sau ®©y sai:


A. MiÒn lµm viÖc chÝnh cña b¶ng tÝnh gåm c¸c cét vµ c¸c dßng.


B. MiÒn giao nhau gi÷a cét vµ dßng lµ « tÝnh dïng ®Ó chøa d÷ liÖu.


C. §Þa chØ « tÝnh lµ cÆp ®Þa chØ tªn cét vµ tªn hµng.


D. Trªn trang tÝnh chØ chän ®­îc mét khèi duy nhÊt.

C©u 4: Khèi lµ tËp hîp c¸c « kÒ nhau t¹o thµnh h×nh ch÷ nhËt. §Þa chØ khèi ®­îc thÓ hiÖn nh­ c©u nµo sau ®©y lµ ®óng:


A. H1…H5

B. H1:H5

C. H1 - H5

D. H1->H5


C©u 5: Hép tªn cho biÕt th«ng tin:

A. Tªn cña cét.




B. Tªn cña hµng.

C. §Þa chØ « tÝnh ®­îc chän.


D. Kh«ng cã ý nµo ®óng.

C©u 6: Thanh c«ng thøc dïng ®Ó:

A. HiÓn thÞ néi dung « tÝnh ®­îc chän.
  B.NhËp d÷ liÖu cho « tÝnh ®­îc chän.

C. HiÓn thÞ c«ng thøc trong « tÝnh ®­îc chän.  D. C¶ 3 ý trªn.

C©u 7: Trong « tÝnh xuÊt hiÖn ###### v×:


A. §é réng cña cét qu¸ nhá kh«ng hiÓn thÞ hÕt d·y sè qu¸ dµi.


B. §é réng cña hµng qu¸ nhá kh«ng hiÓn thÞ hÕt d·y sè qu¸ dµi.


C. TÝnh to¸n ra kÕt qu¶ sai.


D. C«ng thøc nhËp sai. 

C©u 8: §Ó söa d÷ liÖu ta:


A. Nh¸y ®óp chuét tr¸i vµo « cÇn söa.

B. Nh¸y nót chuét tr¸i.


C. Nh¸y ®óp chuét ph¶i vµo « cÇn söa.

D. Nh¸y nót chuét ph¶i.

C©u 9: §Ó l­u trang tÝnh ta chän lÖnh:


A. File\Open.

B. File\New.

C. File\Save.

D. File\Exit.

C©u 10: Trong c¸c c«ng thøc sau c«ng thøc nµo viÕt ®óng:
A. =Sum(A1;A2;A3;A4)


B. =SUM(A1,A2,A3,A4)

C. =sum(A1;A4)



D. =Sum(A1-A4)

C©u 11: Trong c¸c c«ng thøc tÝnh trung b×nh céng, c«ng thøc nµo viÕt sai:

A. =Average(A1:A5)


B. =SUM(A1:A5)/5

C. = Average(A1:A5)/5


D. =(A1+A2+A3+A4)/5

C©u 12: C©u thøc nµo viÕt sai:


A. =sum(A1:A4)
B. =   sum(A1:A4)
C. =SUM(A1:A4)
D. =sum    (A1:A4)

B. Tự luận: (7 điểm)

C©u 1 (3 ®): Sö dông c¸c ký hiÖu phÐp to¸n cña Excel. H·y viÕt c¸c c«ng thøc sau:

a) 162 : 4 - 2  
 

b)
[image: image12.wmf]2
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c) (148 : 2 – 3) . 5
 

Câu 2 (2 đ): Em hãy nêu các bước nhập hàm vào chương trình bảng tính?
Câu 3 (2 đ): Nêu chức năng của các hàm: SUM, AVERAGE, MAX, MIN?
* §¸p ¸n – biÓu ®iÓm:

A. Trắc nghiệm khách quan:  (3 điểm)

Mỗi ý đúng được 0,25 điểm.

	C©u hái
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	§¸p ¸n
	b
	D
	d
	b
	c
	d
	a
	a
	c
	b
	C
	d


B. Tự luận: (7 điểm)

C©u 1 (3 ®iÓm): Sö dông c¸c ký hiÖu phÐp to¸n cña Excel. H·y viÕt c¸c c«ng thøc sau:

a) =(16*16)/4 - 2  
 

hoÆc =16^2/4 – 2.

b)=(5*5*5+3*3)/(4+2)*(4+2)
hoÆc =(5^3+3^2)/(4 + 2)^2

c) (148/2 – 3)*5




Câu 2 (2 ®iÓm): Mỗi ý đúng được 0,5 điểm.
- B1: Chọn ô cần nhập hàm.

- B2: Nhập dấu =.

- B3: Nhập hàm đúng cú pháp.

- B4: Nhấn Enter.

Câu 3 (2 ®iÓm): Mỗi ý đúng được 0,5 điểm.

· SUM: Tính tổng.

· AVERAGE: Tính giá trị trung bình cộng          

· MAX: Xác định giá trị lớn nhất.

· MIN: Xác định giá trị nhỏ nhất.


A. MỤC ĐÍCH, YÊU CẦU: 

- HS hiểu được ý nghĩa và một số chức năng chính của phần mềm Earth Explorer là xem, tra cứu bản đồ thế giới.

- Khởi động và thoát khỏi phần mềm.


- Nắm cách quan sát bản đồ bằng cách cho trái đất tự động quay.


- Phóng to, thu nhỏ khung nhìn và dịch chuyển bản đồ.
B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Cho bảng dữ liệu sau






        1. Tính tổng các giá trị từ ô A1 đến D4





        2. Tìm giá trị nhỏ nhất của khối ô từ A1 đến D4.






        3. Tính trung bình cộng của khối ô từ A1 đến D4





        4. Tìm giá trị lớn nhất của khối ô từ A1 đến D4.

* BÀI MỚI:


* HOẠT ĐỘNG 1: Giới thiêu 

  * GV: Để biết thông tin của một nước như dân số, diện tích, khí hậu,… trên thế giới ta thường xem ở đâu?

  * HS: Ta thường xem trên bản đồ, địa cầu.

  * GV: - Để biết thông tin của một nước trên thế giới một cách thuận tiện, nhanh chóng, rõ ràng công ty Mother – planet (mo rờ pờ lây nit) cung cấp phần mềm Earth Explorer cho phép ta xem và tra cứu bản đồ thế giới.

- Để hiểu rõ phần mềm này ta tìm hiểu bài mới.

* HOẠT ĐÔNG 2: Tìm hiểu phần mềm Earth Explorer
	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Earth Explorer là phần mềm dùng để xem và tra cứu bản đồ thế giới. Hay nói cách khác là phần mềm trái đất cho ta xem thông tin của  250 quốc gia trên toàn thế giới.
	1. Giới thiệu phần mềm: 

 -  Earth Explorer là phần mềm chuyên dùng để xem và tra cứu bản đồ thế giới.

 - Do công ty Mother planet cung cấp.

 - Cho phép xem, tìm kiếm thông tin theo nhiều chủ đề khác nhau của 250 quốc gia.

	HOẠT ĐỘNG 3: Tìm hiểu cách khỏi động phần mềm

	* GV: Để xem được thông tin trên phần mềm đầu tiên ta phải làm gì? – HS khởi động phần mềm
?Hãy cho biết các cách khởi động phần mềm mà em biết? – HS trả lời.

* Gọi một HS khởi động – HS khởi động
	2. Khởi động phần mềm:
  Nháy đúp chuột vào biểu tượng  [image: image13.png]=
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      Earth Explorer trên màn hình nền

	HOẠT ĐỘNG 4: Tìm hiểu cửa sổ phần mềm

	* GV: Cho HS quan sát cửa sổ của phần mềm

* HS: Quan sát

?Hãy cho biết các thành phần trên  cửa sổ  phần mềm?

* HS: Trả lời

* GV: Giới thiệu

?Hãy cho biết thanh công cụ gồm có những nút lệnh nào? – HS quan sát và chỉ ra các nút lệnh.
* Cho HS quan sát

* GV: Để quan sát được đầy đủ 250 quốc gia ta phải cho trái đất quay.
	3. Giới thiệu của sổ phần mềm:

- Thanh bảng chọn chứa các lệnh chính của chươưng trình: File, Maps, Earth Explorer,…
- Thanh công cụ gồm các biểu tượng và các lệnh thường dùng.

- Chính giữa là hình trái đất.
- Bên phải màn hình là thông tin bổ sung dưới dạng bảng dữ liệu.

	HOẠT ĐỘNG 5: Tìm hiểu cách quan sát bản đồ bằng cách cho trái đất  tự quay

	* GV: Thao tác mẫu bằng cách nháy chuột vào các nút lệnh điều khiển – HS quan sát

* Gọi hai em lên thao tác – HS thao tác 

* Cả lớp quan sát trái đất quay.

?Để quan sát được rõ ràng vị trí nào đó ta cần làm gì?
* HS: Ta cần phóng to, thu nhỏ, dịch chuyển khung nhìn
	4. Quan sát bản đồ bằng cách cho trái đất tự quay:

* Các nút lệnh.
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- Left: Xoay trái đất từ trái sang phải.

- Right: Xoay trái đất từ phải sang trái.

- Up: Xoay trái đất từ trên  xuống dưới.

- Down: Xoay trái đất từ dưới lên trên.

- Stop: Dừng quay .



	HOẠT ĐỘNG 6: Tìm hiểu phóng to, thu nhỏ, dịch chuyển bản đồ.

	* GV: Giới thiệu – HS quan sát

* Gọi một HS lên thao tác – HS thao tác.
* GV: Ngoài phóng to, thu nhỏ khung nhìn ta còn có thể xem thông tin theo ý thích (tùy ý) bằng cách dịch chuyển bản đồ để xem.

* Có nhiều cách dịch chuyển bản đồ.

* GV: Thao tác mẫu – HS quan sát

* Gọi một em lên thao tác – HS thao tác

* GV: Nếu các em sử dụng nút lệnh center để xem thông tin thì thông tin đó sẽ được dịch chuyển vào chính giữa để ta xem được rõ hơn có nghĩa là xá định lại trung tâm xem.
* Gọi một HS lên thao tác – HS thao tác

?Để thôi không xem thông tin nữa ta phải làm gì?

* HS: Thoát khỏi phần mềm
	5. Phóng to, thu nhỏ, dịch chuyển bản đồ

 a. Phóng to, thu nhỏ: 
 - Nút  +  : Phóng to khung nhìn

 - Nút  -   : Thu nhỏ khung nhìn

 b. Dịch chuyển bản đồ trên màn hình:

  * Dịch chuyển bằng cách kéo thả chuột:

B1) Nháy chuột vào nút lệnh   [image: image15.png]Save ' Left Right Up Down Stop

__ orth Explorer DEM 3.5

Zoam in Zaom ot

Drag CentelMassure

Day/Might Find Preference

AP AvYZ O 0 Yo/ ©ih % B LPre

Buy now Register Help

- lbania

T Algeria

'~ American Samos
"~ Andorra
 Angols
anguils
 Antarctica
 Antigus and B.
" Arctic Ocean
 Argentina

" Armenia
Anbs

"~ Ashmore and
" Atlantic Ocean
 Australi
 Austria

" Azerbaijan

"~ Bahamas, The
" Bahran

" Baker Island
" Bangladesh

" Barbados

T Bassas da India
 Belarus.

[Republc o Al

[People’s Repui





 B2) Nháy chuột vào vị trí cần di chuyển trên bản đồ.
  * Dịch chuyển bằng nháy chuột:


(Center): Xác định vị trí tâm cần xem.

 Nháy chuột vào nút lệnh – nháy chuột vào vị trí cần xem

	HOẠT ĐỘNG 6: Tìm hiểu cách thoát khỏi phần mềm

	?Nêu các cách thoát khỏi phần mềm mà em biết?

* HS: Trả lời

* Gọi hai em thao tác – HS thao tác
	6. Thoát khỏi phần mềm:

 - C1: Nháy nút Close trên thanh tiêu đề.

 - C2: Gõ Alt + F4

 - C3: File → Exit


E. CỦNG CỐ: 
- Cần nắm vững biểu tượng của Earth Explorer
- Các nút lệnh điều khiển
F. DẶN DÒ: Về tập quan sát bản đồ bằng phần mềm Earth Explorer để tiết sau thực hành.

A. MỤC ĐÍCH, YÊU CẦU:   

- HS thao tác và xem được một số chức năng chính như: Dịch chuyển bản đồ, phóng to, thu nhỏ khung nhìn, dừng dịch chuyển.

- Thông qua việc sử dụng phần mềm HS có thái độ chăm chỉ học tập.

- Biết vận dụng để sử dụng phần mềm trong việc hỗ trợ học tập môn địa lí của mình. 

B. PHƯƠNG PHÁP:     - Học sinh thực hành trực quan trên máy tính 
C. PHƯƠNG TIỆN DẠY HỌC:  - SGK tin 7,  phòng máy tính.
D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ:   


1) Khởi động phần mềm Earth Explorer và chỉ ra thanh bảng chọn, thanh công cụ.

2) Cho biết chức năng của từng nút lệnh.


* BÀI MỚI:    

Câu 1: Khởi động phần mềm Earth Explorer
  Nháy đúp chuột vào biểu tượng  [image: image16.png]=
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 Earth Explorer trên màn hình nền

Câu 2: Quan sát bản đồ băng cách cho trái đất tự quay.

  HS sử dụng thanh công cụ có chứa các nút lệnh để xem

 - Left: Xoay trái đất từ trái sang phải.     


 - Right: Xoay trái đất từ phải sang trái.

 - Up: Xoay trái đất từ trên  xuống dưới.


 - Down: Xoay trái đất từ dưới lên trên.

 - Stop: Dừng quay .





 - Zoom out: Thu nhỏ khung nhìn.
 

 - Zoom in: Phóng to khung nhìn (Mỗi lần nháy chuột vào trái đất tự động phóng to thêm).

* Dịch chuyển bằng cách kéo thả chuột:
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 B2) Nháy chuột vào vị trí cần di chuyển trên bản đồ.

  * Dịch chuyển bằng nháy chuột:


(Center): Xác định vị trí tâm cần xem.

 Nháy chuột vào nút lệnh – nháy chuột vào vị trí cần xem

 * HS thực hành trực tiếp với phần mềm trên máy tính để xem thông tin như các câu hỏi trên.
* GV:  - Hướng dẫn HS thực hành cách nháy chuột chọn nút lệnh để xem thông tin chi tiết.


 - Sửa sai (nếu có)

* Chú ý:  Quan sát trái đất theo màu sắc để phán đoán.


- Vùng biển nông: Màu xanh nước biển nhạt.


- Vùng biển sâu: Màu xanh đậm.

- Đồng bằng: Màu xanh lá cây.


- Cao nguyên: Màu vàng.


- Núi thấp trung bình: Nâu nhạt.


- Núi vùng cao: Màu nâu đậm.

E. DẶN DÒ: - Về nhà tập quan sát trái đất theo nội dung đã học môn địa lí từ trước tới lớp 7.



- Xem tiếp bài “Học địa lí với Earth Explorer để tiết sau học tiếp.


A. MỤC ĐÍCH, YÊU CẦU: 

- HS nắm được các thao tác như: Xem thông tin nhanh về một quốc gia, xem thông tin chi tiết trên bản đồ.

- Nắm cách đo khoảng cách giữa hai vị trí trên bản đồ
B. PHƯƠNG PHÁP: 

 
- Hỏi – đáp, quan sát trực quan, thuyết trình, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Dịch chuyển bản đồ bằng cách kéo thả chuột, nháy chuột.


* BÀI MỚI:


* HOẠT ĐÔNG 1: Tìm hiểu cách dịch chuyển nhanh đến một quốc gia
	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: - Các em không chỉ xem bản đồ bằng cách  nháy chuột hoặc kéo thả chuộtđể tìm quốc gia cần xem. Ta còn có cách tìm đến nhanh quốc gia tùy ý đó là.

- Ta sử dụng bảng thông tin Countries (khân trì) phía bên phải màn hình.

  - GV thao tác mẫu – HS quan sát

  - Bảng Countries cho phép ta tìm đến nhanh một quốc gia và các thành phố lớn của quốc gia đó bằng cách nháy chuột vào tên quốc gia cần.

* Gọi hai HS thao tác – HS thao tác
	* Dịch chuyển nhanh đến một quốc gia hoặc thành phố:

- Sử dụng bảng thông tin Countries để xem, bảng này thường nằm phía bên phải màn hình.
 - Nháy chuột vào tên quốc gia cần xem thông tin.

	HOẠT ĐỘNG 2: Tìm hiểu cách xem thông tin trên bản đồ

	* GV: Để xem thông tin chi tiết trên bản đồ ta sử dụng các bảng chọn để xem.

* GV: Ta sử dụng bảng chọn Maps (Mép)

* GV: Thao tác mẫu bằng cách nháy chuột vào từng lệnh – HS quan sát.

* Gọi ba em thao tác lại – HS thao tác.

* GV: Ta không chỉ có xem thông tin mà ta còn có thể đo khoảng cách theo đường chim bay từ thành phố này đến thành phố khác nhờ vào chức năng của phần mềm.

* GV: Thao tác mẫu

* Gọi hai HS thao tác – HS thao tác.

* GV: Đây là chức năng rất hay (ưu việt) của phần mềm cho phép ta đo khoảng cách giữa hai vị trí trên bản đồ.

* Ví dụ: Đo khoảng cách từ Hà Nội đến Bắc Kinh theo đường chim bay là 2.198.017km.

* Gọi ba HS thao tác – HS thao tác.
	5. Xem thông tin trên bản đồ:

 a) Thông tin chi tiết bản đồ:

B1: Nháy chọn bảng chọn Maps
- All Maps layers {on mép lây ờ} (Ctrl + A): Hiện toàn bộ thông tin.

 - Political boundaries {pô li ti cồ bao đờ ri} (Ctrl +1): Thể hiện đường biên giới.

 - Coastlines {cốt lai} (Ctrl + 2): Đường bờ biển.
- Rivers {ri vơ} (Ctrl + 3): Thể hiện các sông.

- Lat/lon Grids {let/lân} (Ctrl + 4): Thể hiện đường kinh tuyến, vĩ tuyến.

- Countries {khaan trì}: Hiện tên quốc gia.

- Cities {xi tỳ}: Hiện tên thành phố.

- Islands {ai len}: Hiện tên các đảo.

- No Maps layers (Ctrl + n): Hủy thông tin chi tiết.
- Earth quakes {ớt kha khờ}: Hiện vị trí có động đất.

B2: Xem thông tin

b. Tính khoảng cách giữa hai vị trí trên bản đồ:

B1) Nháy chọn nút lệnh Measure {me sờ}.

B2) Nháy chuột vào vị trí đầu cần đo → di chuyển chuột đến vị trí cuối cần đo → thả chuột
B3) Xem độ dài ở hộp thoại

B4) OK


E. CỦNG CỐ: 

- Cần nắm vững nút lệnh Measure để đo khoảng cách giữa hai vị trí.


- Bảng chọn Maps xem tổng thể thông tin về các quốc gia.

F. DẶN DÒ: 

Về xem lại lí thuyết đã học và tập quan sát bản đồ thế giới bằng phần mềm Earth Explorer để tiết sau thực hành.

A. MỤC ĐÍCH, YÊU CẦU:   

- HS biết cách xem nhanh thông tin về một quốc gia.

- Biết sử dụng bảng chọn Maps để xem thông tin.

- Biết sử dụng nút lệnh Measure để đo khoảng cách giữa hai vị trí trên bản đồ. 

B. PHƯƠNG PHÁP:     - Học sinh thực hành trực quan trên máy tính 
C. PHƯƠNG TIỆN DẠY HỌC:  - SGK tin 7,  phòng máy tính.
D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ:   


1) Khởi động phần mềm Earth Explorer và đo khoảng cách từ Bắc Kinh tới Tokeyo, Viên chăn tới Hà Nội.

2) Cho hiện đường biên giới giữa các nước, xem nhanh thông tin về Việt Nam.


* BÀI MỚI:    

Câu 1: Sử dụng bảng chọn Maps để xem thông tin.
 
HS thao tác lần lượt chọn các lệnh của bảng chọn để xem

B1: Nháy chọn bảng chọn Maps

B2: Lựa chọn

- All Maps layers {on mép lây ờ} (Ctrl + A): Hiện toàn bộ thông tin.

 
- Political boundaries {pô li ti cồ bao đờ ri} (Ctrl +1): Thể hiện đường biên giới.

 
- Coastlines {cốt lai} (Ctrl + 2): Đường bờ biển.

- Rivers {ri vơ} (Ctrl + 3): Thể hiện các sông.

- Lat/lon Grids {let/lân} (Ctrl + 4): Thể hiện đường kinh tuyến, vĩ tuyến.

- Countries {khaan trì}: Hiện tên quốc gia.

- Cities {xi tỳ}: Hiện tên thành phố.

- Islands {ai len}: Hiện tên các đảo.

- No Maps layers (Ctrl + n): Hủy thông tin chi tiết.

- Earth quakes {ớt kha khờ}: Hiện vị trí có động đất.
Câu 2: Đến nhanh nước tùy ý.
HS:  - Thao tác bằng cách chọn tên nước ở bảng chọn Countries khung bên phải màn hình.
        - Nháy chọn nước tùy ý và xem thông tin ở trái đất.

Câu 3:  Đo khoảng cách giỡa hai vị trí trên bản đồ. 


HS: B1) Thao tác đo khoảng cách bằng cách nháy chọn nút lệnh Measure → nháy chuột vào vị trí  đầu → nháy chuột vào vị trí hai → thả chuột


        B2) Xem độ dìa theo đường chim bay ở hộp thoại.

Câu 4:  Quan sát trái đất theo ngày hoặc đêm


B1) Nháy chuột vào nút lệnh Day/Night


B2) Quan sát

GV:     - Hướng dẫn học sinh thực hành, sửa sai (nếu có)


- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.
E. DẶN DÒ:


- Về nhà tập quan sát bản đồ với phần mềm Earth Explorer.


- Xem trước bài 5: “Thao tác với bảng tính” phần 1 và 2 để tiết sau học.

A. MỤC ĐÍCH, YÊU CẦU: 

- Điều chỉnh độ rộng của cột, độ cao của hàng.

- Chèn thêm họăc xóa bớt cột, hàng từ đó HS hiểu được các kĩ năng thao tác với bảng tính.

- Có thái độ nghiêm túc trong công việc

B. PHƯƠNG PHÁP: 

 
- Đối thoại, diễn giải, quan sát trực quan, hoạt động nhóm.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động phần mềm Earth Explorer và đo khoảng cách giữa hai vị trí tùy ý trên bản đồ, đọc kết quả đo được.


* BÀI MỚI:


* HOẠT ĐÔNG 1: Giới thiệu


- Các em đã làm quen với bảng tính và đã biết mỗi ô tinh như một cái hộp để chứa dữ liệu.


- Nếu có một cái hộp rộng 5cm, dài 10cm, cao 5cm muốn bỏ vào đó 10 quyển sách biết rằng mỗi quyển sách có độ dày bằng 1,5cm, dài 20cm, rộng 10em.

?Hộp đó có chứa hết 10 quyển sách không? Vì sao?

* HS: Hộp đó không chứa hết 10 quyển sách vì độ cao, chiều dài vượt quá độ cao, chiều dài của cái hộp.

?Vậy em làm thế nào để cất hết 10 quyển sách đó?

* HS: Ta cần thay đổi độ rộng, độ cao của cái hộp.

* GV: Bảng tính có chứa chức năng ưu việt đó. Muốn chứa hết dữ liệu vào ô ta phải điều chỉnh độ rộng, chiều cao của ô.
?Điều chỉnh như thế nào ta tìm hiểu bài mới

* HOẠT ĐỘNG 2: Tìm hiểu cách điều chỉnhđộ rộng cột, độ cao hàng.
     Sử dụng phương pháp quan sát trực quan → nhận biết tình huống cần thiết, đối thoại, diễn giải.

	Hoạt động giáo viên và học sinh
	Nội dung

	* HS: Quan sát trực quan các hình 32, 33, 34, 35, 36, 37 SGK trang 36, 37.
* GV: Chiếu các hình ở SGK và một số ví dụ - HS quan sát

* Ví dụ 1: Ô A2 thể hiện #######

?Điều này có nghĩa là gì?

* HS: Độ rộng của ô hẹp không chứa hết dữ liệu kiểu số.

?Làm cách nào để ô chứa hết dữ liệu?

* HS: Điều chỉnh độ rộng của ô cho hợp lí

* HS quan sát hình 32 ở SGK, kết hợp GV chiếu trên máy.

?Hãy cho biết có những vấn đề nào chưa hợp lí?

* HS: có một số cột có độ rộng quá hẹp hay quá rộng.

?Quan sát hình 33, 34 hãy nhận xét độ rộng của các ô?

* HS: ÔA1 có độ rộng hẹp nên dữ liệu kí tự đã tràn sang các ô bên cạnh, cột B có độ rộng hẹp nên dữ liệu bị che khuất.
?Quan sát hình 35 hãy nhận xét cách hiển thị?

* HS: Nội dung của ô B1 che lấp nội dung của ô A1

* GV: Chốt lại để hiển thị hết nội dung trong ô sao cho cách trình bày  đẹp, khoa học ta cần điều chỉnh độ rộng, hẹp của ô sao cho hợp lí.

* GV: Thao tác mẫu – HS quan sát.

?Nêu cách điều chỉnh độ rộng, hẹp của ô, cột, hàng?

* HS: Trả lời

* GV: Chốt lại – HS ghi bài

* GV: Giả sử có bảng dữ liệu như hình 37, muốn thêm thông tin địa chỉ, lớp vào sau cột B.

?Ta cần phải làm gì? 

* HS: Đưa thêm cột để nhập địa chỉ, nhập lớp vào bảng dữ liệu.

* GV: Đưa như thế nào? Đó là cách chèn thêm cột, hàng vào bảng dữ liệu.
	1. Điều chỉnh độ rộng cột và độ cao hàng:

C1: Nháy đúp chuột vào nút tên cột hoặc tên hàng.
C2: Đưa chuột vào vạch ngăn (Biên cột, hàng) bên phải của ô, bên dưới của hàng sao cho chuột có dạng 

<╫> → di chuyển chuột để điều chỉnh → thả chuột.
C3: B1) Chọn cột, hàng cần điều chỉnh.
B2) Format → Rows → Height columns

B3) Gõ độ rộng cần vào khung Row (columns)                   → OK

	HOẠT ĐỘNG 3: Tìm hiểu cách chèn thêm hoặc xóa cột, hàng

	* GV: Cho HS quan sát hình 38 trên máy kết hợp với quan sát hình ở SGK – HS quan sát.

* HOẠT ĐỘNG NHÓM.

Dựa trên các hình và kiến thức ở SGK

- Nhóm 1, 2, 3: Tìm hiểu các cách chèn thêm cột, hàng.
- Nhóm 4, 5, 6: Tìm hiểu các cách xóa cột, xóa hàng.

* Đại diện nhóm 1 trình bày → cả lớp nhận xét, bổ sung.

* GV: Chốt lại bằng cách thao tác mẫu – HS quan sát.

* Gọi hai em thao tác lại – HS thao tác

* GV: Chèn thêm hàng tương tự như chèn thêm cột.

?Hãy nêu các bước chèn thêm hàng – HS trả lời

* GV: Thao tác mẫu – HS quan sát.

* Gọi hai em thao tác – HS thao tác.

* Giả sử với bảng dữ liệu trên cô không cần cột địa chỉ nữa ta phải làm gì? – HS ta phải xóa bớt đi.

* Đại diện nhóm 4 trình bày → cả lớp nhận xét, bổ sung.

* Gọi một HS thao tác  chọn cột địa chỉ → gõ phím Delete 
* HS quan sát

?Hãy nhận xét bảng dữ liệu vừa được xóa?

* HS: Dữ liệu của cột đó được xóa xạch nhưng cột đó vẫn còn.

* GV: - Để xóa được cột, hàng ta cần thực hiện lệnh xóa.

 - GV thao tác mẫu – HS quan sát.

?Nêu các bước thao tác xóa cột, hàng – HS trả lời

* GV: Chốt lại – HS ghi bài
	2. Chèn thêm hoặc xoat cột, hàng:

 a) Chèn thêm cột hoặc hàng:

* Chèn thêm cột:

B1: Nháy chuột vào  ô của cột cần chèn.

B2: Insert → columns

* Chú ý:  - Cột mới sẽ được chèn vào trước ô được chọn.

* Chèn thêm hàng:

B1: Nháy chuột vào  ô của hàng cần chèn.

B2: Insert → Rows

* Lưu ý: Nếu em chọn nhiều ô của một hàng, nhiều ô của một cột thì khi chèn sẽ được số cột, hàng bằng với số em đã chọn.
* Xóa cột, hàng:

B1: Chọn cột, hàng cần xóa

B2: Edit → Delete


E. CỦNG CỐ: Cần nắm vững cách điều chỉnh độ rộng, hẹp cột, độ cao hàng, chèn thêm cột, hàng.
F. DẶN DÒ: - Về nhà tập thao tác trên máy với nội dung vừa học.



- Làm bài tập 1, 2 SGK trang 44.



- Chuẩn bị bài mới xem tiếp bài 5 mục 3 và 4 để tiết sau học.

A. MỤC ĐÍCH, YÊU CẦU: 

- Biết được sao chép và di chuyển dữ liệu.

- Biết sao chép công thức.


- Hiểu được sự thay đổi của địa chỉ ô khi sao chép công thức.


Từ đó HS sẽ nhận biết được kĩ năng thao tác trên máy.

B. PHƯƠNG PHÁP: 

 
- Quan sát trực quan, hoạt động theo cặp, theo bàn, hỏi - đáp, diễn giải tìm hướng giải quyết vấn đề.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động phần mềm  Excel và mở bài “BAITH4” sau đó chèn thêm hai cột vào trước cột B và ba hàng vào trước hàng 4.

2) Điều chỉnh độ rộng, hẹp cho cột sao cho hợp lí và đẹp



* BÀI MỚI:


* HOẠT ĐỘNG 1: Tìm hiểu cách sao chép và di chuyển dữ liệu.

     Sử dụng phương pháp quan sát trực quan → hoạt động theo cạp, hỏi - đáp, diễn giải.

	Hoạt động giáo viên và học sinh
	Nội dung

	* GV: Khi làm việc với máy tính ta rất cần sự trợ giúp của máy tính sao cho thao tác được nhanh, chính xác, khoa học điều này được thể hiện ở tính ưu việt của bảng tính, cho phép ta sao chép, di chuyển dữ liệu nhanh chóng lại rất dễ dàng.

* HS hoạt động theo cặp: Trao đổi nhớ lại kiến thức đã học ở lớp 6 về sao chép, di chuyển kết hợp với nôi dung ở SGK trang 40, 41.
?Hãy cho biết các nút lệnh dùng để sao chép, di chuyển?

* HS: Trả lời  [image: image18.bmp] Cut, [image: image19.bmp] Copy, [image: image20.bmp] paste.

* GV: Sao chép nội dung các bước tiến hành tương tự ở Word

* HS hoạt động theo bàn: Thảo luận nêu cách sao chép dữ liệu.

* Đại diện bàn trình bày → cả lớp nhận xét, góp ý, bổ sung.

* GV: Thao tác mẫu  - HS quan sát.

* Gọi một em thao tác – HS thao tác

?Cho biết sự khác nhau giữa sao chép ở Word với Excel?

* HS: Ở Excel khi sao chép vùng dữ liệu được bao quanh bởi khung có nét đứt, sao chép xong phải gõ phím Esc để kết thúc.

* GV: - Đó là sao chép còn di chuyển thì sao?

- Di chuyển nội dung ô tính có nghĩa là sao chép toàn bộ nội dung của ô đi nơi khác, đồng thời xóa xạch dữ liệu của ô ban đầu.

- GV thao tác mẫu – HS quan sát.

?Hãy nêu cách di chuyển nội dung ô tính? – HS trả lời
	3. Sao chép và di chuyển dữ liệu:

a) Sao chép nội dung ô tính:

B1: Chọn ô hoặc khối ô có dữ liệu cần  sao chép.

B2: C1) Nháy nút Copy

       C2) Edit → Copy

B3: Nháy chuột vào ô cần sao chép đến.

B4: C1) Nháy nút Paste

       C2) Edit → Paste
B5: Gõ phím Esc để kết thúc.

b. Di chuyển nội dung ô tính:

B1: Chọn ô hoặc khối ô chứa dữ liệu cần di chuyển 

B2: C1) Nháy nút lệnh Cut

       C2) Edit → Cut

       C3) Ctrl + X

B3: Nháy chuột vào ô cần di chuyển đến.

B4: C1) Nháy nút lệnh Paste

       C2) Edit → Paste

       C3) Ctrl + V

	HOẠT ĐỘNG 2: Tìm hiểu cách sao chép công thức trong ô tính

	* GV: Khi tính toán ta nhập công thức để tính toán nếu các ô tiếp theo củng tính toán như vậy, ta nhập công thức như trên và thay vào địa chỉ ô khác.

?Nhập như vậy sẽ như thế nào?

* HS: Nhập như vậy sẽ rất lâu, tốn thời gian lại dễ sai sót.

?Có cách nào để thao tác được nhanh, ít tốn thời gian, chính xác lại không sai sót? Bảng tính có tính ưu viẹt cho phép ta sao chép công thức khi tính toán.
* HS: Quan sát ví dụ ở SGK trang 42 kết hợp với ví dụ của GV trên máy.

- HS trao đổi theo cặp:  Đưa ra nhận xét kết quả khi sao chép nội dung của ô chứa công thức.
* Đại diện cặp trình bày – Cả lớp nhận xét, góp ý  bổ sung.

* GV: Thao tác mẫu – HS quan sát

?Nêu các bước thực hiện sao chép – HS trả lời

* Gọi hai HS thao tác – HS thao tác

* GV: Khi sao chép công thức đến vị trí mới ta thấy công thức đã bị điều chỉnh theo địa chỉ ô, ta gọi đó là địa chỉ tương đối

* Ví dụ: - Bạn A hãy cho biết các bạn ngồi bên tay phải bạn là những bạn nào? – HS  A trả lời

- GV cho bạn A sang bàn 5 và cũng hỏi như thế - HS A trả lời

- GV vẫn là bạn A nhưng ngồi ở bàn khác thì có những bạn khác nhau đi kèm.

* GV: - Ta có thể thay đổi vị trí cho bạn A và bạn A lại nhận được các bạn khác khi đến vị trí mới, điều này ở máy tính gọi là địa chỉ tương đối. Địa chỉ tương đối có nghĩa là không cố định  có thể thay đổi để phù hợp điều kiện cần.

- Ta cũng có thể di chuyển toàn bộ công thức đến vị trí khác.

* GV: Khi ta di chuyển nội dung các ô có chứa công thức có nghĩa là đem toàn bộ dữ liệu có trong ô đến vị trí khác.
?Hãy nhớ lại vaf nêu ra cách di chuyển văn bản ở Word? – HS trả lời.

?Quan sát và cho biết khi ta di chuyển dữ liệu đích có còn không?

* HS: Khi ta di chuyển dữ liệu đích không còn mà nó được đươa đến vị trí mới.

* HS hoạt động theo bàn. Tìm hiểu cách di chuyển công thức và cho nhận xét.

* Đại diện bàn trình bày → cả lớp nhận xét, góp ý bổ sung.

* GV: Khi di chuyển đến vị trí mới nội dung và công thức được di chuyển toàn bộ và không thay đổi còn dữ liệu đích không còn.

* GV: Thao tác mẫu – HS quan sát.

?Nêu các bước thực hiện di chuyển? – HS trả lời

* Gọi hai HS thao tác – HS thao tác
	4. Sao chép công thức:

a. Sao chép nội dung các ô có công thức:

C1) B1: Chọn ô có công thức cần sao chép.

B2: Nháy chọn nút lệnh Copy
B3: Nháy chuột vào ô cần sao chép đến

B4: Nháy nút lệnh Paste

B5: Gõ phím Esc để kết thúc

C2) B1: Nháy chuột vào ô cần sao chép công thức 

B2: Đưa chuột vào ô vuông màu đen nằm ở góc dưới bên phải ô sao cho chuột có dấu cộng (+) nhỏ màu đen

B3: C1) Nháy đúp chuột để sao chép

       C2) Di chuyển chuột để sao chép

B4: Gõ phím Esc để kết thúc.

* Tóm lại: Khi sao chép ô có nội dung là công thức chứa địa chỉ ô, các địa chỉ được điều chỉnh để giữ nguyên quan hệ tương đối về vị trí so với ô đích.
b. Di chuyển nội dung các ô có công thức:

 * Khi di chuyển nội dung cũng như công thức giữ nguyên không thay đổi, còn dữ liệu nguồn (đích) không còn.

B1: Chọn ô hoặc khối ô có công thức cần di chuyển.
B2: Nháy chọn nút lệnh Cut

B3: Nháy chuột vào ô cần sao chép đến

B4: Nháy nút lệnh Paste.

* Chú ý:  Khi thực hiện thao tác nếu thực hiện sai sử dụng lệnh Undo để khôi phục lại


* HOẠT ĐỘNG 3: Bài tập
  
So sánh sự khác nhau cơ bản giữa di chuyển và sao chép công thức.

	Sao chép
	Di chuyển

	- Dữ liệu đích còn
	- Dữ liệu đích không còn

	- Công thức được điều chỉnh thay đổi theo địa chỉ ô
	- Địa chỉ trong công thức không bị thay đổi


Câu 1 SGK trang 44: câu b, c

Câu 3 SGK trang 44:  a)   =C3+D5



  b và c thông báo lỗi




  d)   =A1+B3

E. DẶN DÒ: 

- Về nhà làm các bài tập còn lại.

- Tập sao chép, di chuyển công thức.


- Xem trước bài thực hành 5, bài tập 1 và 2 để tiết sau thực hành

A. MỤC ĐÍCH, YÊU CẦU:   

- Thực hiện được các thao tác điều chỉnh độ rộng, chiều cao của cột, hàng, chèn xóa cột 

- HS có thái độ nghiêm túc trong giờ thực hành.

B. PHƯƠNG PHÁP:     - Học sinh thực hành trực quan trên máy tính 
C. PHƯƠNG TIỆN DẠY HỌC:  - SGK tin 7,  phòng máy tính.
D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ:   1) Điều chỉnh độ rộng củ cột, hàng và chèn thêm một cột

2) chèn thêm hai cột, bốn hàng sau đó xóa đi ba cột, ba hàng.


* BÀI MỚI:    Học sinh thực hành bài tập 1, 2 SGK trang 45, 46, 47
BÀI TẬP 1: Điều chỉnh độ rộng cột, độ cao hàng, chèn thêm cột và hàng, sao chép và di chuyển dữ liệu.

- Khởi động phần mềm Excel: + Nháy đúp chuột vào biểu tượng Excel trên màn hình nền.


+ Mở “BAITH4”: Nháy chọn nút lệnh Open → mở ổ đĩa D → mở thư mục “LOP 7” → chọn tệp “BAITH4” → nháy Open.


a) Chèn thêm cột: - Chèn thêm một cột vào trước cột D để nhập điểm môn tin học

	
	A
	B
	C
	D
	E
	F
	G

	1
	Bảng điểm lớp 7A
	
	
	
	

	2
	
	
	
	
	
	
	

	3
	TT
	Họ và tên
	Toán
	Tin
	Vật lí
	Ngữ văn
	ĐTB

	4
	:
	:
	
	
	
	
	



B1: Nháy chuột vào một ô của cột D → Insert  →  Columns

B2: Nhập từ bàn phím thêm cột tin học (lúc này cột D cũ đã được rời thành cột E mới nhường chỗ cho cột D mới.


b) Chèn thêm hàng: - Chèn thêm hàng trống và thực hiện các thao tác điều chỉnh độ rộng 


B1: Chọn 3 ô của 3 hàng (Bắt đầu từ hàng 4) → Insert  →  Rows (số hàng được chèn thêm vào trước hàng 4 là ba hàng – hàng 4 cũ đã chuyển thành hàng 7 mới


B2: Nhập thêm thông tin về học sinh.


- Điều chỉnh độ rộng: Đưa chuột vào biên phải của cột, bên dưới của hàng sao cho cuột có dạng  <╫>,        giữ chặt chuột trái và di chuyển choụut để chọn → thả chuột.

c) Kiểm tra công thức: Trong các ô của cột G (ĐTB) xem công thức có còn đúng không? Khi ta chèn thêm một cột D ở câu a. Nếu không đúng thì điều chỉnh lại và sao chép cho các ô còn lại của cột G.


* Kiểm tra: B1: Nháy đúp chuột vào ô G4 → kiểm tra



        B2: Nếu chưa đúng  chỉnh sửa lại → gõ phím Enter.


* Sao chép: Nháy chuột vào ô G4 đưa chuột vào ô vuông màu đen nằm góc dưới bên phải ô sao cho chuột có dấu công màu đen → nháy đúp chuột để sao chép.

d) Di chuyển dữ liệu:  Từ hàng 7 lên hàng 5


B1:  Chèn thêm một hàng vào trước hàng 5: Insert → Rows

B2: Chọn hàng 8 và di chuyển dữ liệu. Edit →  Cut

B3: Nháy chuột vào hàng 5 để dán dữ liệu. Edit → Paste

B4: Xóa bớt hàng 8. Chọn hàng 8 →  Edit → Delete

BÀI TẬP 2: Tìm hiểu các trường hợp tự điều chỉnh của công thức khi chèn thêm cột mới.


a) Di chuyển dữ liệu: Di chuyển cột D (Tin học) tạm thời sang một cột khác (cột I) sau đó xóa đi cột D, sử dụng hàm để tính ĐTB của ba môn (toán, vật lí, văn).


B1: Chọn dữ liệu ở cột D (Tin học)  → Edit →  Cut


B2: Nháy chuột vào ô I1 → Edit → Paste


B3: Nháy chuột vào một ô của cột D →  Edit → Delete


B4: Nháy chuột vào ô F4 và sử dụng hàm để tính  =Average(C4:E4) → gõ phím Enter


B5: Sao chép công thức cho các ô còn lại của cột F.

b) Chèn thêm cột: Chèn thêm một cột vào sau cột E (ngữ văn) và sao chép dữ liệu của cột G vào (tin học) → kiểm tra công thức → rút ra kết luận về ưu điểm của việc sử dụng hàm.


B1: Chèn thêm một cột vào trước cột F  → Insert → Columns


B2: Di chuyển dữ liệu từ cột I (Tin học) → Edit →  Cut


B3: Nháy chuột vào cột F để dán → Edit → Paste


B4: Kiểm tra công thức ở cột G, công thức không thay đổi.

  * Ưu điểm của việc tính toán bằng hàm nếu có thay đổi thì dữ liệu được cập nhật tự động theo.


c) Chèn thêm cột: Vào trước cột G (ĐTB) và nhập thêm điểm của môn công nghệ, kiểm ta công thức trong cột H (ĐTB).
  
Cách làm tương tự như các câu trên.


d) Lưu dữ liệu vừa chỉnh sửa: C1) Nháy chọn nút lệnh  [image: image21.bmp] Save






    C2) File →  Save






    C3) Ctrl + S

* GV:  - Hướng dẫn học sinh thực hành →  sửa sai (nếu có)


- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ:  


- Về nhà tập làm lại bài tập 1 và 2 SGK trang 45, 46.


- Xem trước bài tập 3, 4 SGK trang 47, 48 để tiết sau thực hành tiếp.


A. MỤC ĐÍCH, YÊU CẦU:   

- Thực hiện được các thao tác sao chép, di chuyển dữ liệu, công thức 

- HS có thái độ nghiêm túc trong giờ thực hành, có ý thức bảo vệ máy.

B. PHƯƠNG PHÁP:     - Học sinh thực hành trực quan trên máy tính 
C. PHƯƠNG TIỆN DẠY HỌC:  - SGK tin 7,  phòng máy tính.
D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ:   1) Chèn thêm một cột vào trước cột B, xóa bớt cột H

2) Chèn thêm ba hàng vào trước hàng hai, xóa bớt bốn hàng từ hàng 7 đến hàng 10.


* BÀI MỚI:    Học sinh thực hành bài tập 3, 4 SGK trang  47, 48
BÀI TẬP 3: Thực hành sao chép và di chuyển công thức, dữ liệu.

a) Tạo trang tính mới: HS mở cửa sổ Excel và nhập dữ liệu như sau.

	
	A
	B
	C
	D
	E
	F

	1
	1
	2
	3
	
	
	

	2
	4
	5
	6
	
	
	

	3
	
	
	
	
	
	



b) Sử dụng hàm hoặc công thức: Tính tổng của khối ô từ A1 đến C1 tại ô D1


C1:   =A1+B1+C1        Gõ phím Enter để kết thúc    → Kết quả  = 6

C2:   =Sum(A1:C1)
  Gõ phím Enter để kết thúc    → Kết quả  = 6

c) Sao chép công thức: Của ô D1 vào ô D2, E1, E2, E3 

  - Sao chép công thức sang ô D2 dữ liệu được cập nhất tự động (tính tổng của khối ô từ A2 đến C2)


=Sum(A2:C2)  → Kết quả  = 15

  - Sao chép sang ô E1 công thức tự động điều chỉnh thành    =Sum(A1:D1) → Kết quả  = 11

  - Sao chép sang ô E2 công thức tự động điều chỉnh thành    =Sum(B2:D2) → Kết quả  = 26

  - Sao chép sang ô E3 công thức tự động điều chỉnh thành    =Sum(B3:D3) → Kết quả  = 0 (Kết quả bằng 0 vì chưa có dữ liệu nhập vào, nếu ta nhập dữ liệu vào thì lập tức có kết quả ngay).

* Nhận xét: Bảng tính có tính ưu virtj nếu ta sử dụng hàm và địa chỉ ô để tính toán khi sao chép hoặc di chuyển dữ liệu được tự động cập nhật theo.


d) Sao chép nội dung:

  - Sao chép nội dung ô A1 vào khối ô H1 đến J4  ( toàn bộ dữ liệu của ô A1 lần lượt được sao chép vào từng ô của cả khối ô H1 đến J4.

  - Sao chép khối ô A1:A2 vào các khối ô A5:A7; B5:B8; C5:C9.


+ Sao chép vào khối A5:A7. dữ liệu chỉ dán vào hai ô A5, A6.


+ Sao chép vào khối B5:B8. dữ liệu được sao chép lặp lại 1, 4, 1, 4.


+ Sao chép vào khối C5:C9. dữ liệu  chỉ dán vào hai ô C5 và C6.

BÀI TẬP 4: Chèn và điều chỉnh độ rộng cột, độ cao hàng theo hình 51 SGK trang 48.

	
	A
	B
	C
	D
	E
	F
	G

	1
	Danh sách lớp em
	
	
	
	
	

	2
	TT
	Họ và tên
	Địa chỉ
	Điện thoại
	Ngày sinh
	Chiều cao
	Cân nặng

	3
	
	
	
	
	
	
	


  - Lưu tên tệp tin:   B1:  File → Save as → Mở ổ đĩa D → mở thư mục “LOP7”


        B2: Gõ tên vào khung File name 

       Chọn Save

  - Nhập thêm dữ liệu.

  - Điều chỉnh độ rộng cột sao cho hiển thị hết nộ dung trong ô bằng cách đưa chuột vào biên phải của cột → di chuyển chuột để điều chỉnh → thả chuột

  - Lưu dữ liệu vừa chỉnh sửa: Nháy chọn nút lệnh [image: image22.bmp] (Save).
* GV:  - Hướng dẫn học sinh thực hành → sửa sai (nếu có)


- Nhận xét ưu khuyết trong quá trình thực hành của học sinh.

E. DẶN DÒ: Về xem lại các bài tập ở SGK và sách bài tập để tiết sau làm bài tập.


A. MỤC ĐÍCH, YÊU CẦU: 

- HS vận dụng lí thuyết đã học từ bài 1 đến bài 4 để giải một số bài tập ở SGK và sách bài tập.

- Nhằm củng cố kiến thức đã học  cho học sinh.

B. PHƯƠNG PHÁP: 

 
- Hoạt động theo cặp, hỏi - đáp, hoạt động nhóm.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Khởi động phần mềm  Excel và mở bài “BAITH4” sau đó chèn thêm hai cột vào trước cột B và ba hàng vào trước hàng 4.


2) Điều chỉnh độ rộng, hẹp cho cột sao cho hợp lí và đẹp.



* BÀI MỚI:

Câu 1: Trong ô E10 có công thức =A1+B3 công thức được điều chỉnh như thế nào?


a) Sao chép ô E10 vào G12. Ta biết khi sao chép địa chỉ ô được điều chỉnh thay đổi theo.
   - Xét cột E với cột G cách nhau hai cột, hàng 10 với hàng 12 cách nhau hai hàng ( 

+  A1 Sẽ điều chỉnh thay đổi thành C3.

+  B3 Sẽ điều chỉnh thay đổi thành D5.    Như vậy ô G12 sẽ có công thức =C3+D5 

b) Sao chép E10 vào G2. 

c) Sao chép E10 vào E3  (  Cả b và c được thông báo lỗi vì trang tính không có ô với địa chỉ điều chỉnh như vậy. Ta đã biết khi sao chép công thức vào một ô nào đó thì địa chỉ của ô đó phải lứn hơn ô đích.

- Xét hàng 10 của ô đích E10 > hàng 2, 3 của ô được sao chép đến.

d) Di chuyển công thức ô E10 sang G12. Khi di chuyển dữ liệu đích (nguồn) được giữ nguyên không thay đổi ( địa chỉ ô mới nhận được công thức  vẫn là =A1+B3
Câu 2: Cho bảng dữ liệu sau



* Cho biết kết quả hàm tính tổng:



a)  =Sum(A1:A3)             ( Kết quả = 150




b)  =Sum(A1:A3,100)      ( Kết quả = 250




c)  =Sum(A1+A4)            ( Kết quả = 25




d)  =Sum(A1:A2,A5)       ( Kết quả = 75




* Kết quả hàm tính trung bình cộng:




e)  =Average(A1:A5)        ( Kết quả = 50




f)  =Average(A1:A6)         ( Kết quả = 62,5



g)  =Average(A1:A9)        ( Kết quả = 51,6




k)  =Average(A3:A8)         ( Kết quả = 58,8




e)  =Average(A2:A6,15)     ( Kết quả = 60

Câu 3: (HS thảo luận theo cặp)
   Những phát biểu sau đúng hay sai? (Ghi chữ Đ vào câu trả lời đúng, ghi chữ S vào câu trả lời sai).

a) Để xóa hàng hoặc cột ta chọn cột hoặc hàng và gõ phím Delete. (S)

b) Khi sao chép công thức ở ô tính thì nội dung ô tính mới giống hệt nội dung ô đích. (S)

  c) Sao chép và di chuyển từ một ô thì nội dung ô này sẽ được giữ nguyên (sao chép) hoặc bị xóa đi (di chuyển) nhưng nội dung ô đích thì giống nhau. (Đ)
Câu 4: Muốn xóa hẳn một hàng ra khỏi bảng tính ta chọn hàng và thực hiện?   Edit → Delete

Câu 5:  Công thức =B2+A3 được đặt trong ô B3, nếu sao chép công thức này sang ô D4 thì công thức ở ô D4 sẽ là?   =D3+C4.

Câu 6:  (HS trao đổi theo cặp).  Giả sử ô C4  có công thức =C3+B4 nếu chèn thêm một cột mới vào trước cột C, hỏi công thức trong ô C4? Công thức của ô C4 được dịch chuyển sang ô D4 và có dạng =D3+B4, lúc này ô C4 sẽ không chứa dữ liệu mà dữ liệu đó đã được dịch chuyển sang ô D4.
Câu 7:  Cho biết hàm tính tổng, tính trung bình cộng, tìm giá trị lớn nhất. tìm giá trị nhỏ nhất?

- Sum:  Hàm tính tổng




- Max: Hàm tìm giá trị lớn nhất


- Average: Hàm tính trung bình cộng


- Min: Hàm tìm giá trị nhỏ nhất

Câu 8: Để chèn thêm cột vào trang tính ta thực hiện?  Insert → Columns
Câu 9:  Trang tính có thể chứa những kiểu dữ liệu nào? Kí tự, số, thời gian, hình ảnh, …

Câu 10:  Khi chiều dài của số > chiều rộng của ô thì Excel sẽ hiển thị như thế nào? Hiển thị #####
Câu 11:  Cho biết sự khác nhau giữa sao chép và di chuyển.

	Sao chép
	Di chuyển

	- Địa chỉ ô sẽ được điều chỉnh theo
	- Địa chỉ ô giữ nguyên không thay đổi

	- Dữ liệu đích còn
	- Dữ liệu đích không còn nó đã được di chuyển đến vị trí mới.

	- Sử dụng lệnh Copy
	- Dữ dụng lệnh Cut


E. DẶN DÒ: 

Về ôn tập lại lí thuyết đã học từ bài 1 đến bài 5 để tiết sau kiểm tra một tiết thực hành.

(((((((((

A. MỤC ĐÍCH, YÊU CẦU: 

- HS biết cách trình bày bảng dữ liếuao cho đẹp, biết điều chỉnh độ rộng cột, chọn màu cho chữ, chọn cỡ chữ, kiểu chữ.

- Biết cách nhập dữ liệu vào ô tính.


- Biết sử dụng công thức và hàm để tính toán.


- Biết sao chép công thức

  * Bằng cách vận dụng lí thuyết đã học từ bài 1 đến bài 5 để thực hiện.

  * Nhằm đánh giá khả năng tiếp thu bài, độ bền kiến thức của học sinh từ bài 1 đến bài 5 đã học.
B. CHUẨN BỊ: 


Bài kiểm tra, phòng máy.

C. BÀI MỚI: 

Có đề đính kèm

D. DẶN DÒ: 


Về ôn tập lại toàn bộ kiến thức đã học ở học kì I để tiết sau ôn tập.


A. MỤC ĐÍCH, YÊU CẦU: 

- Giúp học sinh ôn lại kiến thức đã học ở học kì I, nhằm củng cố, khắc sâu độ bền kiến thức.
B. PHƯƠNG PHÁP: 

 
- Hoạt động theo bàn, hỏi – đáp, trao đổi theo cặp.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Lên khởi động Excel và mở bài “BAITH5”, sau đó sao chép  khối ô từ B2 đến H10 sang Sheet 3.


2) Di chuyển khối ô từ B2 đến H10 sang Sheet 2, nhận xét sự khác nhau giữa sao chép và di chuyển..



* BÀI MỚI:

Câu 1: Chương trình bảng tính là gì?
- Chương trình bảng tính là phần mềm giúp ghi lại dữ liệu dưới dạng bảng và thực hiện tính toán.

Câu 2:  Phân biệt bảng tính, trang tính, trang màn hình.


- Bảng tính:  Là một tệp tin (File), bảng tính gồm nhiều trang tính.


- Trang tính: Gồm các cột, hàng là miền làm việc chính của bảng tính, một trang tính gồm có nhiều trang màn hình.

- Trang màn hình: Là vùng dữ liệu ta nhìn thấy trên màn hình.

Câu 3: Phân biệt cột, ô, hàng.

- Cột được đánh số thứ tự A, B, C,… theo chiều ngang.

- Hàng được đánh số thứ tự 1, 2, 3, … theo chiều dọc.

- Ô tính là vùng giao nhau giữa cột và hàng dùng để chứa dữ liệu.

Câu 4: Hãy cho biết các thành phần chính trên trang tính?


- Thanh bảng chọn chứa các bảng chọn.


- Thanh công thức hiển thị dữ liêu, công thức tính toán trong ô được chọn.


- Thanh công cụ chứa các nút lệnh thường dùng.


- Có cột, hàng, ô tính.


+ Hộp tên: Hiển thị địa chỉ ô được kích hoạt.


+ Khối ô: Các ô được chọn.

Câu 5:  Nêu cách chọn đối tượng trên trang tính?


- Chọn một ô: Nháy chuột vào ô cần chọn.


- Chọn một cột: Nháy chuột vào nút tên cột cần chọn.


- Chọn một hàng: Nháy chuột vào nút tên hàng cần chọn.


- Chọn khối ô: Di chuyển chuột để chọn.

- Chọn nhiều khối ô không liền kề: Di chuyển chuột để chọn khối đầu + giữ phím Ctrl + lần lượt chọn các khối tiếp theo.


- Chọn cả trang tính: Nháy chuột vào ô giao nhau giữa tên cột và tên hàng

Câu 6: Phân biệt cách hiển thị dữ liệu trên trang tính.


- Dữ liệu kiểu số được căn đều về bên phải ô.


- Dữ liệu kí tự được căn đều về bên trái ô.

Câu 7:  Cho biết các phép toán trên trang tính. +, -, *, /, ^, %

Câu 8: Nêu cách nhập công thức, nhập hàm.

	Nhập công thức
	Nhập hàm

	B1: Nháy chọn ô cần nhập công thức
	B1: Nháy chọn ô cần nhập hàm

	B2: Gõ dấu =
	B2: Gõ dấu =

	B3: Nhập biểu thức hoặc các phép toán
	B3: Nhập hàm

	B4: Gõ phím Enter để kết thúc
	B4: Nhập địa chỉ ô hoặc số → Gõ phím Enter để kết thúc


Câu 9: HS hoạt động theo bàn.
- Nêu cách đến nhanh địa chỉ ô H10: Nháy chuột vào hộp tên và gõ H10 → Gõ phím Enter.

- Nêu cách chọn đối tượng bằng sử dụng hộp tên.

B1) Nháy chuột vào hộp tên

B2)    -  Gõ 2:2 chọn  hàng 2
;

- Gõ A:D chọn bốn cột A, B, C, D



- Gõ A:A  chọn cột A;


- Gõ A2:H7 chọn khối ô 


- Gõ B2:C6,D1:E7,B8:E15 chọn nhiều khối ô

Câu 10:  Giả sử cần tính tổng giá trị của ô C2 và D4 sau đó nhân với giá trị của ô B2 công thức nào sau là đúng?
a) (D4+C2)*B2

b) D4+C2*B2

c) =(D4+C2)*B2

d) =(D4+C2)B2
Câu 11: - Giả sử ta chọn một khối ô A3:D20. Hãy cho biết ô nào được kích hoạt?  Ô A3 

    - Cách nhập hàm nào sau đây là không đúng?

a) =  Sum(5,A3,B1)
        b) =Sum(5;A3;B1)
  c) =Sum(5,A3,B1)
     d) =Sum  (5,A3,B1)

Câu 12: Giả sử ô B3 có công thức như sau =B2+A3 nếu ta sao chép công thức này sang ô D4 thì trong ô D4 sẽ là:  =D3+C4 vì: khi sao chép công thức từ ô B3 sang ô D4 địa chỉ ô sẽ được thay đổi theo.

- Xét cột: từ B đến D tăng hai cột.


- Xét hàng: Từ 3 đến 4 tăng một hàng

Câu 13: Giả sử ta có khối ô A1:A5 lần lượt chứa các số 10, 7, 9, 27, 2. Hãy cho biết kết quả tính trung bình cộng:    Kết quả = 11
E. DẶN DÒ: 
- Về xem lại nội dung đã ôn tập.
- Xem tiếp kiến thức đã học từ bài 1 đến bài 5 để tiết sau ôn tập tiếp.


A. MỤC ĐÍCH, YÊU CẦU: 

- HS vận dụng các hàm đã học để tính toán.

- Ôn lại kiến thức đã học ở học kì I. Nhằm củng cố, khai thác sâu độ bền kiến thức cho HS.
B. PHƯƠNG PHÁP: 

 
- Hoạt động theo bàn, hỏi – đáp, trao đổi theo cặp.

C. PHƯƠNG TIỆN DẠY HỌC:

 
- Giáo án, SGK tin 7, một máy tính để giới thiệu.

D. TIẾN TRÌNH LÊN LỚP: 


* BÀI CŨ: 


1) Cho bảng dữ liệu sau.





a) Tính trung bình cộng của khối ô từ A1 đến C5 vào ô C6.






b) Sao chép khối ô từ A1 đến C5 vào Sheet 2, sau đó nhận xét kết quả.






c) Sao chép công thức ở ô C6 vào ô H3 và nhận xét kết quả của ô H3.


* BÀI MỚI:

Câu 1: HS hoạt động theo nhóm

   Ở Việt Nam nhiệt độ trung bình tính bằng oc (Celsius), còn một số nước trên thế giới tính bằng oF. Công thức biến đổi giữa hai thang nhiệt độ là F = 9/5 + 32.

B1: HS tính

B2: Sao chép công thức cho các ô còn lại.  Đưa chuột vào ô vuông màu đen mằm góc dưới bên phải ô B3 → nháy đúp chuột.


B3: Thêm cột  để nhập phần tính toán độ chênh lệnh giữa hai thang nhiệt độ.



B3.1: Insert  → Columns



B3.2: Tính chênh lệch, =B2-A2 → Sao chép công thức cho các ô còn lại.

Câu 2:  HS hoạt động theo nhóm

  Tính chỉ số khối cơ thể để xác định gầy, béo theo công thức BIM = W/H2. Trong đó W – cân nặng (Kg), H – chiều cao (mét), BIM  <18,5 → người gầy, 18,5 < BIM  < 25 → người trung bình, BIM > 25 → Người béo
Câu 3: Cụm từ F5 trong hộp tên có nghĩa là? Địa chỉ ô F5 đang được kích hoạt

Câu 4: -  Bạn An nói “Một nhóm các ô tạo nên một khối, bạn An nói đúng hay sai? Bạn An nói chưa chính xác (Sai) vì khối ô được tạo bởi một nhóm các ô liền kề tạo thành hình chữ nhật.


  - Cho bảng dữ liệu sau: Hãy cho biết dữ liệu ở các ô trong bảng chứa kiểu dữ liệu nào?








- Ô A1,D1: Dữ liệu kiểu ngày.









- Ô B1:   Dữ liệu kiểu kí tự.









- Ô C1:   Dữ liệu kiểu số

E.  DẶN DÒ: 


Về ôn lại kiến thức đã học để tiết sau kiểm tra hết học kì I

Phần I:          BẢNG TÍNH ĐIỆN TỬ


Tiết 1 – Bài 1: CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ?





Tiết 2 – Bài 1: CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ?





Ô giao nhau giữa tên cột và tên hàng





Tiết 3:       BÀI THỰC HÀNH 1  (t1)


LÀM QUEN VỚI CHƯƠNG TRÌNH BẢNG TÍNH EXCEL





Tiết 4:       BÀI THỰC HÀNH 1  (t2)


LÀM QUEN VỚI CHƯƠNG TRÌNH BẢNG TÍNH EXCEL





Tiết 5 – Bài 2:      CÁC THÀNH PHẦN CHÍNH VÀ DỮ         	                       LIỆU TRÊN TRANG TÍNH  (t1)





Tiết 6 – Bài 2:      CÁC THÀNH PHẦN CHÍNH VÀ DỮ         	                       LIỆU TRÊN TRANG TÍNH  (t2)





Tiết 7:       BÀI THỰC HÀNH 2  (t1)


LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN TRANG TÍNH





Tiết 8:       BÀI THỰC HÀNH 2  (t2)


LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN TRANG TÍNH





Tiết 9:      LUYỆN GÕ PHÍM BẰNG TYPING TEST  (t1)





10 Min





Tiết 10:      LUYỆN GÕ PHÍM BẰNG TYPING TEST  (t2)





VD: 30 Min





Tiết 11:      LUYỆN GÕ PHÍM BẰNG TYPING TEST  (t3)





VD: 30 Min





Tiết 12:      LUYỆN GÕ PHÍM BẰNG TYPING TEST  (t4)





Tiết 13 – Bài 3:      THỰC HIỆN TÍNH TOÁN TRÊN TRANG TÍNH  (t1)





Tiết 14 – Bài 3:      THỰC HIỆN TÍNH TOÁN TRÊN TRANG TÍNH  (t2)





Tiết 15:      BÀI THỰC HÀNH 3  (t1)


                BẢNG ĐIỂM CỦA EM





Tiết 16:      BÀI THỰC HÀNH 3  (t2)


                BẢNG ĐIỂM CỦA EM





Tiết 17 – Bài 4:      SỬ DỤNG CÁC HÀM ĐỂ TÍMH TOÁN  (t1)





Tiết 18 – Bài 4:      SỬ DỤNG CÁC HÀM ĐỂ TÍMH TOÁN  (t2)





�
A�
B�
C�
D�
�
1�
15�
11�
100�
�
�
2�
30�
16�
20�
�
�
3�
4�
5�
7�
�
�
4�
9�
120�
3�
�
�






�
A�
B�
C�
D�
�
1�
15�
�
100�
�
�
2�
30�
16�
quê�
�
�
3�
�
150�
7�
�
�
4�
9�
em�
3�
�
�






Tiết 19:      BÀI THỰC HÀNH 4  (t1)


                BẢNG ĐIỂM CỦA  LỚP EM





Tiết 20:      BÀI THỰC HÀNH 4  (t2)


                BẢNG ĐIỂM CỦA  LỚP EM
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Tiết 21:      BÀI TẬP  


                





Tiết 23:      HỌC ĐỊA LÍ VỚI EARTH  EXPLORO (t1)





Tiết 24:    HỌC ĐỊA LÍ VỚI EARTH  EXPLORER (t2)


THỰC HÀNH   





Tiết 26:    HỌC ĐỊA LÍ VỚI EARTH  EXPLORER (t4)


     THỰC HÀNH   





Tiết 25:      HỌC ĐỊA LÍ VỚI EARTH  EXPLORO (t3)





Tiết 27 – Bài 5:      THAO TÁC VỚI BÀNG TÍNH (t1)





Tiết 28 – Bài 5:      THAO TÁC VỚI BÀNG TÍNH (t2)





Tiết 29:           BÀI THỰC HÀNH SỐ 5 (t1)


                 CHỈNH SỬA TRANG TÍNH CỦA EM   





Tiết 30:           BÀI THỰC HÀNH SỐ 5 (t2)


                 CHỈNH SỬA TRANG TÍNH CỦA EM   





Tiết 31:      BÀI TẬP
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Tiết 32:      KIỂM TRA MỘT TIẾT


               THỰC HÀNH TRÊN MÁY





Tiết 33:      ÔN TẬP (t1)





    Cột B2 sẽ thay đổi thành D3


     Cột A3 sẽ thay đổi thành C4





Tiết 34:      ÔN TẬP (t2)
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